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Oscilloscope
Model CS328A
Application CS300 Features
•

•
•

•

Separate, freely movable and
resizable windows to display the
signal, a zoomed signal view, and
the frequency spectrum of the
signal, and control panel
The zoomed signal view optionally
tracks the signal view cursor.
Spectrum Analysis with a variety of
conditioning windows and display in
log or linear format.
Each signal window includes a
time/amplitude tracer, and two
markers for comparison purposes.
Colours are user definable.

•
•

•
•
•
•
•

Signal averaging (exponential, block
and peak hold) and low pass filtering.
Signal measurement, including Peak t0
Peak, RMS, DC, pulse width, period and
frequency.
Copy and Paste graphic or data to other
applications.
Save and Open from disk.
User defined units, signal names and
scaling (offset and gain).
Text annotation of each graph.
Web server for remote viewing of LAN
connected unit.

www.cleverscope.com
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1 Overview
The Cleverscope CS328A
CS328A is a USB connected PC based mixed signal oscilloscope, spectrum analyser, and signal generator
which brings benefits to the user that are unavailable from traditional stand-alone oscilloscopes. This innovative approach
delivers an unbeatable combination of affordability, ease of use and documentation of test results with the simple “Copy”
and “Paste” facility. Graphs and data can be copied and pasted to other applications, saved or loaded from disk, and printed.
Cleverscope hardware resources include:
• Two 10 bit, 12bit, or 14 bit analog channels sampling simultaneously at 100 MSa/s. AC or DC coupled. The bit
resolution is field upgradeable by changing the sampler circuit board.
• Scaling and offsetting to view 50mV full scale offset to any value between –8 and +8 V.
o Gain automatically set from 20mV full scale to 800V full scale by choosing graph view and probe switch setting.
o Offset automatically set from 0 to ±4 or 40V in 10/100 mV increments by choosing graph view. As an example
20 mV signals may be viewed superimposed on a 3V DC level.
• Analog triggering of the waveform in view with a resolution of 1% of the display height. The analog trigger may
optionally be conditioned with a low pass, high pass or noise filter.
• One external trigger, threshold adjustable from 0 to ±20V in 40 mV increments.
• Eight digital inputs sampling at 100 MSa/s, threshold adjustable from 0 to 8 V in 10 mV increments.
• A hardware trigger system based on a rising or falling edge on any input signal, optionally qualified by a user
determined digital input combination and a minimum or maximum trigger duration.
• A rear panel I/O connector with a 100 Mbit/s bi-directional LVDS/RS422 link, and three RS422 outputs defaulting
to sampling started, trigger received and sampling stopped.
• Each channel (two analog, trigger and 8 digital) includes 4M samples of storage, providing up to 40 ms of
simultaneous storage for all channels, with 10 ns resolution.
o The sample storage may be allocated as between 2 to 1000 frames varying in size from 2M to 4000 samples.
These may be used as a history store for reviewing previously captured signals, or to capture up to 1000 trigger
events with a minimal 2 µs inter-frame delay, while maintaining time relative to the first trigger for all succeeding
frames.
• 25 MHz 5th order Anti-alias filter for improved Spectrum Analysis performance.
• Triggered LED and Power LED on the front panel.
• Input power range from 6 ~ 12V, 5W provided by a universal mains adaptor.
• Low jitter (1 ps rms) sampling clock for 70 dB spurious free dynamic range.
• Self calibration to ensure DC performance specifications is met.
• An optional plug-in signal generator, 0-10MHz, sine, square or triangle.
• Enclosure size: 153 x 195 x 35 mm.
Cleverscope software resources include:
• Separate, freely moveable and resizable windows to display the signal, a zoomed signal view, and the frequency
spectrum of the signal, and control panel.
o The zoomed signal view optionally tracks the signal view cursor.
• Spectrum analysis with a variety of conditioning windows and display in log or linear format.
• Each signal window includes a time/amplitude tracer, and two markers for comparison purposes. Colours are user
definable.
• Signal averaging (exponential, block and peak hold) and low pass filtering.
• Full mathematical functions including + - / * sqrt integral differential and filtering.
• Signal measurement, including Peak to Peak, RMS, DC, pulse width, period and frequency.
• Copy and Paste graphic or data to other applications.
• Save and Open from disk.
• User defined units, signal names and scaling (offset and gain).
• Text annotation of each graph.
• Web server for remote viewing of LAN connected unit.
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An example of a typical mixed signal window is shown below:

The Cleverscope application is designed to allow the capture, display, storage and analysis of signals on a Windows
compatible PC. The CS300 Cleverscope application is shipped on a CD with every unit and may also be obtained over the
internet by visiting the www.cleverscope.com website.
Minimum requirements are a Pentium PC with at least 256 MB of memory running Windows Vista, Windows XP or
Windows 2000.

8
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2 Quick Getting Started Guide
This guide will get you up and running quickly. There are three parts:
•
•
•

Showing some basics of using Cleverscope by compensating the new probes.
A quick look at how to use the Signal Generator.
Generator
The keyboard shortcuts.
shortcuts

Note If you have not installed the Cleverscope application software, do this now following the instructions that came with
it.

2.1

Cleverscope Basics and Probe Compensation

2.1.1.1 Connect the Cleverscope Acquisition Unit
On the Cleverscope Acquisition Unit hardware:
1. Connect the DC power cable to POWER IN, and plug the power adaptor into the mains. Observe the green power
light.
2. Connect the USB cable to USB and to the PC.
Note If this is the first time, place the CD in the CD drive, and allow windows to find the drivers. This may take
some time. Accept the non-digitally signed driver. When Windows tells you the hardware is installed, you are ready
to proceed.

2.1.1.2 Acquire a Signal for Display
If you have not installed the Cleverscope application software, do this now following the instructions that came with it.
Start the Cleverscope application software.
Go to the Cleverscope Control Panel window.
1. Ensure both channel A and B are enabled by clicking on the enable buttons so that they both
display
.
2. Connect a signal to Channel A. You could use the Probe Compensation output, or connect the
Signal Generator output from the back of the Cleverscope to Chan A, using the scope probe,
and BNC adaptor (in the little plastic bag), if you have the Signal Generator fitted.
3. Click
to automatically scale the Scope Graph
and set the trigger settings based on the signal you
have connected. You should wind up with something
like this:

The following instructions explain how to set up the
acquisition manually. This helps you fine tune what
Autoset has initially selected.
4. In the TRIGGER area, use the Source box to select the
trigger source (Chan
Chan A in this instance).
),

5. On the special cursor toolbar (
click on the rising edge trigger cursor button (
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Select the Scope Graph by either clicking on it or selecting it from the Window menu.
1. Use the up ( ) and down ( ) vertical display buttons and the vertical expand ( ) and contract
( ) buttons for channel A to size the displayed waveform the way you would like to see it. As
an example you could select 0.50 volts per major horizontal gridline as shown to the right.
2.

Position and click the trigger cursor so that trigger amplitude is set to the value you want. You
can also type the trigger value directly into the Level window. Here we have selected 700 mV

Go to the Cleverscope Control Panel window.
to acquire a single frame of signal data. The Scope Graph will then display the
1. In the AQUIRE area, click
acquired signal. Here is the example signal. Note the trigger lines at 700 mV.

2. The auto-fit buttons ( and ) for channel A and B can be used to bring the signal traces into view. Cleverscope
will apply the optimum vertical scaling and positioning for the signal data.
3. For the vertical scale, the positioning and scaling of the signal trace with respect to time can be altered using the
horizontal display buttons.

Note The trigger point is always positioned at time zero on the horizontal axis.

10
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2.1.1.3 Acquire the Compensation Signal
Go to the Cleverscope Control Panel window.
1. In the ACQUIRE area, set the Probe attenuation to x10.
2. In the TRIGGER area, set the trigger Level to 1 V.

Select the Scope Graph window.
1. Set the A channel graph axis to include the voltage range 0 to 4V.
2. Set the time axis to include the range –750 µs to + 750 µs.
3. Plug the scope probe into the A channel, attach the hook probe tip, and ensure the probe switch is set to x10.
Connect the ground crocodile clip to the right hand ground terminal. Connect the probe to the left hand Probe
Comp output terminal.

Go to the Cleverscope Control Panel window.
1. Click
right.

and you should see a graph similar to that shown to the

Note The graph may have either over shoot

or slow rise time

.
2. Adjust the small red screw in the body of the
probes BNC connector until the graph is flat. This
compensates the probe capacitance and ensures
flat frequency response.
3. Repeat with the other oscilloscope probe.
Note You may like to do this on B channel, to familiarize yourself with the B channel controls.
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2.2

How to use the Signal Generator

If you have not already compensated the probes please go to the Cleverscope Basics and Probe Compensation section above
and do this now.

2.2.1.1 Connect the Signal Generator
If the Signal Generator hardware has not been installed in the Cleverscope Acquisition Unit then please install it now
following the instructions that came with it.
On the Cleverscope Acquisition Unit hardware:
1. Connect one end of a BNCBNC-BNC cable to SIG GEN at the back.
2. Connect the other end of the cable to CHAN A at the front. This will allow observation of the signal being generated
on the Scope Graph.
Graph

2.2.1.2 Setup a Signal Generator output
Start the Cleverscope application software.
Go to the Cleverscope Control Panel window.
1. Click View and select Display Sig Gen Controls.
Controls
Go to the S ignal Generator Control window.
1. Set Amplitude to 2 V, set Offset to 0 V, and set Waveform type to sine.
2. Set Sweep Method to Single Freq.
3. Set Base Frequency to 1k Hz, set Adjust to 0.1, and set Freq Range to 20k Hz so
that the Output Frequency equals 3k Hz.

2.2.1.3 Acquire the Signal Generator output
Go to the Cleverscope Control Panel window.
1. In the ACQUIRE area, set the Probe attenuation to x1.
2. In the TRIGGER area, set the trigger Level to 0 V.
and you should see a graph
3. Click
similar to that shown to the below.

12
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2.3

Keyboard Shortcuts

Movement:
and
Shift +
Ctrl +

move the cursor left and right
and
move the graph left and right
and
change the x-scale up or down

and move the selected graph up and down
Shift + and move the selected graph up and down
Ctrl + and change the y-scale up and down
Markers:
1 and 2 set markers one and two
Spacebar sets the next marker
Graph Viewing:
Tab swaps channels
A autoscales the graphs
PageDown zooms in on the tracer
PageUp zooms out on the tracer
L locks the tracking graph position on the current scope graph tracer position
F10 automatically sets the graph scales and trigger settings
Control:
C or Ctrl + C copies the graph to the clipboard
X or Ctrl + X clears the graph
P or Ctrl + P prints the graph
F1 chooses the Pan/Tracer cursor
F2 chooses the Annotation cursor
F3 chooses the Rising Trigger cursor
F4 chooses the Falling Trigger cursor
Sampling:
F7 initiates a single acquisition
F8 initiates automatic acquisition
F9 initiates triggered acquisition

Mouse Wheel:
The mouse wheel acts as a virtual knob on whatever control was last selected. So if you select the Chan A Contract
button, and then use the Mouse Wheel, the wheel acts as a virtual knob on the Channel A Volts/div.
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3 Cleverscope Navigation and Control
The Cleverscope application uses a Control Panel to setup and control signal acquisition. It uses display windows to show
alternative but simultaneous views of signal and spectrum data. It also has additional windows that control the way the signal
data is process and displayed as well as control of the optional Signal Generator.
Generator
The windows that can be displayed are:
Cleverscope Control Panel

Scope Graph

Tracking Graph

controls, cursors, pull-down
menus

main signal display window

used with the Scope Graph for a
close-up view

XY Graph

displays an XY plot of Chan A
against Chan B
Spectrum Graph

displays the signal spectrum
Signal Information Window

displays signal statistics

Note You can individually size and position each window to optimize the ease of use and view-ability of signal and
spectrum data.

14
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Maths Graph

Maths Equation Builder

Signal Generator Control

displays Maths Equation Builder
results

builds equations to process signals

signal generator output controls

Notes

accompanying notes can be added

Signal Generator Simulator

virtual built-in signal generator controls
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Only the Cleverscope Control Panel has pull down menus as shown below:
File Menu

Settings Menu

View Menu

open and save signal data, printing

set-up and options

selects which windows are displayed

Edit Menu

copying and clearing graphs

Window Menu

for selecting the active window

Help Menu

keyboard shortcuts, license and version
info

16
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3.1

Keyboard Shortcuts

As well as using the mouse to navigate and control Cleverscope there are a number of keyboard shortcuts that can be used
to save time and improve ergonomics. These are described below:
Movement:
and
Shift +
Ctrl +

move the cursor left and right
and
move the graph left and right
and
change the x-scale up or down

and move the selected graph up and down
Shift + and move the selected graph up and down
Ctrl + and change the y-scale up and down
Markers:
1 and 2 set markers one and two
Spacebar sets the next marker
Graph Viewing:
Tab swaps channels
A autoscales the graphs
PageDown zooms in on the tracer
PageUp zooms out on the tracer
L locks the tracking graph position on the current scope graph tracer position
F10 automatically sets the graph scales and trigger settings
Control:
C or Ctrl + C copies the graph to the clipboard
X or Ctrl + X clears the graph
P or Ctrl + P prints the graph
F1 chooses the Pan/Tracer cursor
F2 chooses the Annotation cursor
F3 chooses the Rising Trigger cursor
F4 chooses the Falling Trigger cursor
Sampling:
F7 initiates a single acquisition
F8 initiates automatic acquisition
F9 initiates triggered acquisition
Mouse Wheel:
The mouse wheel acts as a virtual knob on whatever control was last selected. So if you select the Chan A Contract
button, and then use the Mouse Wheel, the wheel acts as a virtual knob on the Channel A Volts/div.
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4 Cleverscope Control Panel
The Cleverscope Control Panel contains all of the controls and menu items
for capturing, and saving signal data.

4.1

Signal Acquiring

Use the AQUIRE button controls to start and stop signal
capture in the following three different modes:
Single is a single shot, based on the trigger condition being
met. This is for capturing a single frame positioned around a
trigger point.
Auto free-runs (unless there is a trigger), this is for free running untriggered signal capture.
Triggered is just like single, expect that following a trigger and display,
sampling for a trigger is automatically restarted. This is for capturing
repetitive waveforms positioned around a constant trigger point.

4.1.1 Autoset
The Autoset button automatically sets the graph scales and
trigger settings. It places Chan A in the bottom half and Chan
B in the top half of the graph and shows 3 cycles of the signal in the
Scope Graph and 2 cycle in the Tracking Graph.
Graph This is an easy way to
view a new set of signals.

4.1.2 Channel Enabling
The channel Enabled buttons turns each channel on
or off.

4.1.3 AC/DC Coupling
The AC/DC Coupling buttons set each channels
coupling to either AC or DC coupled.

4.1.4 Anti-aliasing Filter Bandwidth
The BW buttons set each channels bandwidth to either 20 MHz or 100 MHz. The Cleverscope
Acquisition Unit employs 5th order low pass anti-aliasing filters on each channel to prevent high
frequency out of band signals from aliasing back into the displayed signal graph. The unit samples simultaneously for both
channels at 100 M samples/s and the corner frequency of the anti-aliasing filters can be selected to be either 20 MHz or 100
MHz.

4.1.5 Probe Attenuation
The Probe attenuation for each channel can be set to x1,
x1 x10,
x10 x100,
x100 x1k,
x1k x20,
x20 x50 or x200 to match the
attenuation switch settings of the connected probe. Click on the x1 text to see the drop down menu.
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4.1.6 Duration, Resolution, N Display and F Sample
The sampling Duration is the length of time for which a continuous sequence of samples is
available for display. The time Resolution is the minimum time between samples available for
display.
Duration and the Resolution are updated after an acquisition has been started using the
Single,
Single Auto or Triggered buttons. The Duration is at least equal to the time width of the
Scope Graph,
Graph but may be longer to make best use of the sample buffer. The Resolution is set
by the number of samples available in each frame. A total of 4 or 8 million samples divided by
the number of sample frames are available. Reducing the number of sample frames increases
the number of samples available, and so will increase the time resolution. Here the sampling
duration is 8.158 ms, with a time resolution of 10ns per sample.
N Display shows the number of samples on the display and the number of samples that would
be saved if you did a ‘File/Save As..’.
F Sample shows the sample frequency in Hertz. The example shows 100MHz. If you use an
external sample clock this will be different.

4.1.7 Averaging
The Averaging button turns averaging on and off. Averaging arithmetically averages a
number of signal frames together in the PC to reduce the effect of noise, or to see the longterm value of a varying signal.
On the Settings menu, clicking Averaging allows control of both PC based averaging with
Weighting mode and Number of averages,
averages and acquisition based averaging with Acquisition
averages.
averages See the Methods for Displaying Signals section below for acquisition averaging
using the Waveform avg display method.
Weighting mode allows you to select one of three types of averaging: Linear,
Linear Exponential and Peak.
Peak This is used in
conjunction with Number of averages as explained below.
Linear averaging applies equal weighting over a number of signal frames, processing the number of frames chosen in
Number of averages before presenting the result.
Exponential averaging provides a moving average where a greater weighting is applied to more recently acquired frames
than older frames. The averaged frame is displayed after every acquisition. Each new frame is scaled prior to being added
to the aggregated past signal. The scaling is determined by the Number of averages.
averages A large number results in a small
proportion of the new signal contributing to the average.
Peak averaging is used to accumulate maximum frequency points from the spectra of a number of frames and is therefore
only applied to data displayed in the spectrum graph. It may be used to generate a frequency response graph (Gain/Phase
plot).
Because noise is random, and has an average value of 0, averaging will reduce the effective amplitude of the noise in each
time sample. The amount of reduction is dependant on Number of averages – making this number larger, will reduce the
noise more, but it will take longer to settle the signal being measured.
On the Settings menu, click Reset Average (or Ctrl + R) to reset the average to 0.

Cleverscope CS328A User Manual

19

4.1.8 Lock Result
When Lock Result is turned on, it inhibits updates from the sampler. This is especially useful
when using Maths and you want to zoom in on the result on the Tracking Graph without the
Maths being re-applied.

4.1.9 Get Frame Buffer
Get Frame gets the specified size of the frame buffer. The size of the frame buffer can be Full,

50%, 10%, 5%, 2% or Seq. Click on the ‘Full’ text to display a drop down menu list.
This can be particularly useful when saving data where you still want to be able to zoom in
and out with full resolution of the signal data.

4.2

Display Controls

Controls related to signal data storage and display are located in the DISPLAY area.
The Cleverscope acquisition unit is able to hold a number of sequential frames so that a
history of older frames can be recalled.
Following an acquisition the Current Frame number represents the latest frame acquired. To
display an earlier frame, click on the down control, or type a number directly into Current
Frame.
Frame The graphs will update to display the signal in the frame selected. Current Frame ‘1’ is
always the oldest frame, the higher the number, the more recent the frame. The maximum is
set on the Settings menu, clicking Acquisition settings and setting the Number of Frames.
Frames The
4 Million samples available in the Cleverscope acquisition unit are divided between the
Number of Frames allocated.
The Tracer buttons lets you select which channel the tracer will apply to. The tracer is a small
black circle that can be moved along the A or B channel signal trace by selecting a display
graph (Scope, Spectrum, Tracking, etc) and simply moving the mouse left or right.
As the tracer is moved along a signal (or spectrum) its position in both amplitude and time (or
frequency) is displayed in the Information area at the top of the display graph. The tracer
assists the accurate positioning of markers which enable points of interest to be tagged and
calculations on selected segments of signal data to be undertaken. See also the section on
Scope Graph below for a description on the use of the tracer and markers.
Cleverscope lets you save signal data as either a Cleverscope, text or binary file. On the
File menu, click either Save As,
As Save Graph as Text,
Text, Save Graph as Binary or Save to do
this. The file path for the last stored file is displayed in the path display box.
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4.2.1 Method for Displaying Signals
Display Method selects the method of displaying signal data. The choices are Sampled,
Sampled Peak
Captured, Filtered,
Captured
Filtered Repetitive,
Repetitive and Waveform avg.
avg
When Sampled
Sampled is selected, samples are taken at regular intervals from the sample frame. None
of the intermediate samples are displayed, which means that some signal information, such as
high frequency signals, or pulses will not be seen. The sampling interval depends on the
maximum frequency or time resolution required to be displayed and is automatically selected
by Cleverscope depending on graph display settings.
When Peak Captured is selected, all samples are processed, with both the minimum and
maximum value of the signal being displayed at every pixel point on the screen. Hidden pulses
will become visible, and high frequency content will be seen as a solid bar on the screen.
When Filtered is selected, a 1st order low pass filter with a corner frequency of 1 MHz is
applied to the recorded samples. Filtering may be useful when viewing low frequency (<500
kHz) signals at low levels, as sample noise is significantly reduced.
When Repetitive is selected, acquired signals are repetitively sampled over many points to
build up a picture of one cycle of the signal. This results in high frequency repetitive
waveforms being displayed with greater time resolution. This method only works with
repeating signals.
When Waveform avg is selected, waveform averaging is performed in the Cleverscope
Acquisition Unit (CAU). The CAU captures multiple frames in quick succession, averages these
frames, and transfers the result to the PC. This is much faster than averaging in the PC. See
the Averaging section below for PC based averaging.
On the Settings menu, clicking Averaging allows you to select the Acquisition averages that
are used when Waveform avg is selected. The choices are 4, 16,
16 64,
64 or 128.
128 A higher number
increases the averaging.
Note
Waveform averaging requires a stable trigger and is only active when Triggered
acquisition is used. Waveform averaging automatically increases the number of frames being
recorded to one more than the waveform averages selected. Once you complete using
waveform averaging you may wish to set the number of frames to a lower number to increase
time resolution.

Cleverscope CS328A User Manual

21

4.3

Triggering

All the triggering controls are grouped in the TRIGGER area, apart from the trigger cursors
which are with the other cursors at the top of the Cleverscope Control Panel.
Panel
The Slope button is used for selecting whether the voltage level will be increasing or
decreasing through the trigger point when triggering occurs. The triggering slope is initially
determined by the choice of an upward or downward trigger cursor but it can be changed at
any time using the slope button without changing the level of the trigger point.
The trigger Source selection box is used to determine the source of triggering which can be
channel A, channel B, the external trigger, the digital inputs or the link input available on the
Mini-Din connector at the back of the capture unit.
The triggering Level is normally set using the trigger cursors in conjunction with the Scope
Graph however it may also be set using the triggering level selection box. A triggering level
may be either typed into the box or the up and down buttons can be used to raise or lower
the triggering level. A separate level is remembered for each source channel.
The Pre Trigger time displayed is the time between the first sample in a frame and the trigger
point. The trigger point is always set at time zero in the Scope Graph.
Graph The amount of pretrigger time is determined by how much pre-trigger time you are requesting to view in the
Scope Graph.
and
) sets the
Graph Using the Scope Graph left and right horizontal controls (
pre-trigger time. If the number is negative you are capturing signal before the trigger occurs.
If the number is positive you are waiting the given time following a trigger before capturing
the signal.
The trigger Filter is used to improve trigger capture. The choices available are Low Pass,
Pass Hi
Pass,
Pass Noise or None (no filtering).
Low Pass filtering is used to capture a low frequency signal in the presence of high frequency
noise.
Hi Pass
Pass filtering is used to capture high frequency signals (such as edges) in the presence of a
low frequency signal; for example triggering on a pulse on a mains frequency waveform.
Noise filtering is used to achieve a more reliable trigger in the presence of large amounts of
noise. This is done by increasing the hysteresis band about the trigger point. A wider hysteresis
band means that the signal amplitude must be wider than the hysteresis band to ensure
reliable triggering. The standard hysteresis band is 1/10 a vertical division. When noise
filtering is enabled it becomes 1 division. Signals must fully transition through the hysteresis
band to cause a trigger.
The Digital Pattern is an optional qualifier to the analog trigger. When Not Required is
selected, analog triggering proceeds as explained above. When Required is selected, the
analog trigger cannot take place until the digital inputs match the digital pattern chosen. As an
example, assuming the Digital Pattern is Required as set to the right, an analog trigger will not
be recognized until Digital Inputs 1 and 2 matches 0 and 1 respectively. Inputs labelled X are
‘don’t care’. See the Digital Triggering section below for more detail.
Period – Count trigger provides additional trigger control on the interval between two triggers
or the counting of triggers. Refer to figure 3 below for the timing diagram of the following
selections. Selecting Trig 1~2 < Min allows a trigger if the interval between Trigger 1 and
Trigger 2 is less than min time. Selecting min<T1~2 < max allows a trigger if the interval
between Trigger 1 and Trigger 2 is between min time and max time. Selecting Trig 1~2 > max
allows a trigger if the interval between Trigger 1 and Trigger 2 is greater than max time.
Selecting Count Trig 1 allows a trigger when Trigger 1 has occurred count times. Selecting
Count Trig 2 allows a trigger when Trigger 1 occurs followed by Trigger 2 occurring count
times.
Trigger 1 is the main trigger as setup in the TRIGGER area on the Cleverscope Control Panel
Panel.
el
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To setup Trigger 2,
2 on the View menu, click Display Trigger 2 Settings (or Ctrl + T). On
Trigger 2 source,
source select Trigger 1 inverted to make Trigger 2 the inverted trigger of Trigger 1.
1
On Trigger 2 source
source,
urce select Trigger 2 definition to define Trigger 2 as per the Trigger 2
definition area below. These controls operate the same as the equivalent controls for Trigger
1. The diagram below is displayed when the Help button is clicked:

Figure 1: Period Trigger Timing Diagram

4.3.1 Digital Triggering
When Dig Trig is selected as the triggering Source then Cleverscope will trigger when the digital
inputs match the pattern set by the digital input selection box, shown to the right.
There are two groupings of inputs:
OR inputs:
qualified with the
AND inputs:
qualified with the
AND (

symbol above them,
symbol above them.

) or OR ( ) can be selected for each digital input by clicking directly on the

or

symbol.

To achieve a trigger:
1. Any one of the OR conditions must be met
AND
2. All of the AND conditions must be met.
Conditions are:
0 – the digital input must be below the digital threshold
1 – the digital input must be above the digital threshold
X – the digital input is ignored
- the digital input transitions from 0 1
- the digital input transitions from 1
0
As an example, the pattern shown will cause a trigger if input 1 = 0, input 2 = 1, and either input 7 falls or input 8 rises.
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4.4

Cursors

When you click on one of the cursor buttons shown, you will be able to zoom a graph,
or annotate it, or set a trigger level.
The ‘grabbing hand’ or Pan cursor is used to pan the graph by clicking and dragging anywhere
inside the graph window to slide the graph into its desired position.
The horizontal zoom cursor is used to horizontally expand the graph in which it is used. The
vertical zoom cursor is used to vertically expand the graph in which it is used.
The ‘selected area’ zoom cursor is used to select a rectangle to zoom into by clicking on the top
left corner and then dragging, and releasing at the bottom right corner of the rectangle to be
zoomed into.
The annotation cursor is used to annotate graphs. Following its selection you can click at a
position in a graph where it is desired to locate text. Drag the little open circle to move the
annotation. The horizontal position of the text is locked to a position in time corresponding to
where the annotation cursor was clicked. The vertical position of the text is locked to a voltage
level corresponding to the where the annotation cursor was clicked and for whichever channel
(A or B) was selected at the time.
The rising slope trigger cursor is used to set the trigger level for triggering on a rising edge. The
channel that is to be the trigger source, and the axis to be used to set the trigger level, are
determined by whichever channel (A or B) is selected at the time the trigger cursor is clicked.
The falling slope trigger cursor is used to set the trigger level for triggering on a falling edge.

4.5

Cleverscope Menus

The Cleverscope File,
File Edit,
Edit Settings,
Settings View,
View Window and Help pull down menus are
all available from the Cleverscope Control Panel window. The graphs do not contain
pull down menus.

4.5.1 File Menu
The File menu lets you save signal and graph data, open saved data for display and
analysis, print graphs and exit the application.

The standard, familiar Windows open and save file dialogs are used to save and
open files. Open lets you open APC files (*.apc) containing previously saved
Cleverscope signal data. It can only be used to open APC files. Text files must be
opened using the Open Graph from Text.
Text
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Save,
Save Save As and Save Graph as Text let you save signal data as APC or text files.
If you save signal data in an APC file then your Cleverscope settings will also be
saved along with the signal data. This means that when you reopen an APC file the
data will be displayed in the display graphs exactly as it was when you saved it and
all the Cleverscope settings as defined through the various menu items in the File,
File
Settings,
Settings and View menus will also be reapplied. Text files must be saved using the
Save Graph as Text.
Text Cleverscope automatically sizes the graphs to fit the restored
signal when opening text files.
Save Graph as Binary lets you save graph data to binary file format. The file
structure is shown on the Save Graph as Binary dialog.
Print Options is used to choose what other information is printed with the graph.
You can choose the date, time and a text description to be printed above a graph
printout.
Print is used to print the currently selected graph or signal information window.
Exit lets you exit the Cleverscope application.

4.5.1.1 File Options
File Options is used to control the way files are opened and saved.
Save Options allow automatic logging of the signal data. When Save Manually is
selected, files are only saved from the File menu. When Save using Fast Save button
button
is selected, the Fast Save button
is shown in the tool bar. Clicking this button
saves the graph to an incrementing file name. When Save on Trigger is selected, a
file is automatically saved on every trigger (this includes an Auto trigger). The
button is shown on the right of the Trigger button. Toggling this disables and
enables the automatic save. When Save on Duration elapsed is selected, a file is
saved every Auto save duration (secs) following a trigger. ). The
button is shown on the right of the Single button.
Toggling this disables and enables the automatic save. When Save following Open is selected, the file is automatically saved
after any file is opened and after any processing, including maths. This is particularly useful for post-processing logged files.
If Save as Text is selected the file is saved as text, otherwise a full APC file is saved. For all automatic saves a base file name
must be specified in Save File Base Name and the file increment is controlled with Save start and Save stop.
stop Save start is
automatically incremented with each save.
Open Options allow the automatic opening of saved files. This can be used in conjunction with Save Options to automatically
process files. When Open Manually is selected, files are only opened from the File menu. When Open using Single Acquire is
selected, the file is opened every time the Single button is pressed. The
button is shown to the left of the Single button.
Toggling this disables and enables the automatic open. When Open Automatically
Automatically is selected, the file is opened
automatically. Click on the Single button to start the auto open. The
button is shown to the left of the Single button.
Toggling this disables and enables the automatic open. When Open Automatically, Data Only is selected, the file is opened
automatically, but only the data is extracted from the file. None of the Cleverscope settings will be loaded. Click on the Single
button to start the auto open. The
automatic open.

button is shown to the left of the Single button. Toggling this disables and enables the

If Open as Text is selected the file is opened as text, otherwise a full APC file is opened. For all automatic opens a base file
name must be specified in Open File Base Name and the file increment is controlled with Open start and Open stop.
stop Open
start is automatically incremented with each open.
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4.5.2 Edit Menu
Copy Graph lets you copy an image of the last selected graph or information window to the clip
board. You can then paste the copied item into a document or similar in another application.
Clear Graph lets you clear signal data from the last selected graph.

4.5.3 Settings Menu
The Settings menu contains all the options, preferences, and settings related to the
acquiring and analysis of signal data, including calibrating your CAU. In addition,
you can choose different names, colours, and units for displaying graphs.

4.5.3.1 Analog Names and Units
Analog Names and Units lets you use units other than volts or dBs when displaying
signal data.
To set up custom units you need to define the relationship between the internal
units in volts and the units to be used for displaying signal data.
A plot showing the relationship between internal units in Volts and your custom
units must be a straight line. Points 1 and 2 fix this straight line, and therefore define
the scaling between internal units and your custom units.
As an example, suppose a light energy generating system connected to channel A
had a terminal voltage of 0.28V for 3.4 J of output energy, and a terminal voltage
of 12.6V for 76 J of output energy.
To customize the units for this system you would enter 0.28 for Pt. 1 under
for Channel A. You would then also enter 12.6 for
and 3.4 for Pt. 1 under
Pt. 2 under
and 76 for Pt. 2 under
for Channel A. Then type J into
Time Graph Units
and Energy into Time Graph Units
. Channel B can
be similarly customized for the Time Graph,
Graph as can both channel A and B for the
Linear, Logarithmic and Gain/Phase Frequency Graphs (spectrum graphs).
Both Units
Units and Name labelling for the horizontal X axis can also be customized
whether it be for time, or frequency (for linear, logarithmic or gain/phase graphs).
The zero dB reference point for the logarithmic Frequency (spectrum) graph can also
be customized. The default 775 mV corresponds to 0dBm into a 600 ohm load. To
display dBV change this value to 1.
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4.5.3.2 Digital Names and Colours
Digital Names and Colours controls what digital inputs are displayed, what colour
they are, their name, and how big the digital display area is.
The Active check boxes change which digital signals are displayed. The Colour boxes
select each signals colour. You can change the name of a signal by typing in the
Name fields.
In the Digital Graph Height box, select either Normal or Large to change the height
of the Digital Graph,
Graph Large is twice the size of Normal.
Normal

4.5.3.3 Acquisition settings
Acquisition settings adjusts your Cleverscope Acquisition Unit for
external trigger and digital input threshold voltages, the number of
frames stored, sampler resolution, link output, update rate, and
external clock source.
The threshold voltage for the external trigger can be set to any level (at increments of 12.5 mV)
between –6 and 18 volts by dialling, typing or nudging the voltage up and down.
The level determining when a digital input is read to be a ‘1’ as opposed to a ‘0’ (digital input
threshold) can be set to be any voltage between 0 and 10 volts in 10mV increments.
The Cleverscope acquisition unit can store up to 4 million samples of signal data per channel (if you
have the 8M upgrade then you can store 8 million samples). These samples can be allocated to a
single frame or can be divided among multiple frames. This is so that a history of previously captured
frames can be recalled or so successive trigger events can be captured with a minimal 20 µsec inter
frame delay.
Sample storage is allocated evenly between the Number of Frames defined, which can be up to 2999.
If 2999 frames are defined then each will contain 1300/2600 samples.
Frames per capture determines how many of the Number of Frames stored are updated on each
capture. The Frames per capture must always be 1 less than the Number of Frames
Frames stored. As an
example, if the Number of Frames is 50, and the Frames per Capture is 20, every time you click Single,
20 frames will be captured. Each frame will wait until the next trigger occurs before being recorded.
This is useful, for example, to capture 20 serial data messages, so they can be decoded when you look
at them.
The LINK output on the back of the Cleverscope acquisition unit can be enabled to link to another
Cleverscope acquisition unit for 4 channel sampling. To enable this, under Link Output select the
Enabled light to on. To use the LINK output for serial communications select Enabled light to off. You
must have the CS1020 link cable connected between the two CAU’s for this to work. If you use the
Link Output enabled, use normal triggering on the master Cleverscope application, and set the trigger
source to Link on the slave Cleverscope application. You can run two Cleverscope applications at the
same time by renaming Cleverscope.exe to something else – such as Cscope 2.exe.
If you have a 12 bit or 14 bit sampler upgrade installed then you can chose which sampler resolution
to use. If the 12 bit resolution is chosen you cannot display the External trigger on digital graphs. If
you have the 14 bit resolution selected, you cannot display the External Trigger, or Digital Inputs 5-8.
You can still trigger on the External Trigger and Dingital Inputs 5-8 however. The storage used for
these inputs is re-used for the extra analog bits.
The Update Rate can be set to 20, 10 or 5 Frame/sec. This is useful to reduce processor load in slower
PC’s.
If an external clock option is installed in your Cleverscope acquisition unit, you can select the use of
the external clock source by selecting External.
External
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4.5.3.4 Choose Acquirer and set connection
Choose Acquirer and set connection lets you select
the hardware you wish to use to acquire signal
data (or virtual hardware in the case of the internal
Simulated Signal Generator). The choices are
Simulated Sig Gen,
Gen Cleverscope,
Cleverscope Soundcard,
Soundcard
APC901,
APC901 and APC901A
APC901A.
901A
If you select the APC901
APC901 or APC901A
APC901A then you
must also select the Serial port that the Strobes
APC hardware is connected to.
The application supports both USB and Ethernet
connected Cleverscope Acquisition Units (CAU).
When using an Ethernet interface three connection
options are available – connect to a specific IP
address, find the first free CAU, or connect to a
specific serial number. The Ethernet interface
supports DHCP and specified IP addressing. Refer
to the section Using the Ethernet Cleverscope for
more detail.
The Ethernet interface runs at about 5 Mbyte/sec.
The USB interface runs at about 18 Mbyte/sec for CAU firmware versions 6435 and above.

4.5.3.5 Acquirer Scaling
Acquirer
Acquirer Scaling lets you define scaling and offset to be applied to measurements
made by the Strobes hardware (901 and 901A) and soundcards to compensate for
any difference between volts as read by the acquirer and any associated input
circuitry and the actual volts at the input.
An X/Y plot showing the linear relationship between the actual volts at the input and
the measurement in volts as made by the acquirer must be a straight line. Pt.
Pt. 1 and
Pt. 2 fix this straight line, and therefore define the scaling and offset to ensure that
the volts as read in Cleverscope are the same as the actual volts present at the input.
For example, if by measurement the acquirer reads 10mV for a real 23 mV signal and
1.2 Volts for a real 1.1 Volt signal, then Pt.
Pt. 1 and Pt. 2 should be as shown on the
right.
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4.5.3.6 Spectrum
Spectrum lets you select the type of Fourier transform to be applied, the windowing technique
to be used, whether phase information is plotted in degrees or radians, and whether Phase
should be plotted between -180 and 180 degrees or 0 to 360 degrees.
The Fourier Transform Type can be RMS Amplitude,
Amplitude Power,
Power Power Density,
Density or Gain/Phase.
Gain/Phase
The RMS Amplitude returns the magnitude of a signal in volts. RMS amplitude is the most
common type of Fourier transform. The root mean square (RMS) voltage for each frequency
bin is displayed. This value is equivalent to a continuous sinusoid at the bin frequency with RMS
amplitude equal to that displayed. The RMS value of a sinusoid is a constant voltage equal to
the sum of each squared instantaneous voltage value divided by the time over which the
sinusoid is measured.
The Power spectrum returns the magnitude of the power content of an equivalent continuous periodic signal at the bin
frequency. Assuming a voltage input, Power spectrum represents the power dissipated at each frequency bin into a one ohm
resistor. The Power spectrum can be scaled by setting the 0 dB reference level. For example, let the reference value be 1W
dissipated in a 50 ohm load:
From P= V2/R, V = (PR) = (1 x 50) = 7.07 V.
Therefore, set the reference level to 7.07 V.
The Power Density returns the magnitude of the power spectral density. This is the power content of an equivalent
continuous periodic signal at the bin frequency divided by the frequency width of the bin. The reference is used as for Power
spectrum.
Gain/Phase assumes that Channel A is connected up to the input of a system under test and that Channel B is connected to
the output of the system. By performing a Fourier analysis on frames of signal data representing the input and output of a
system, gain versus frequency and the phase versus Frequency can be plotted for the system under test.
The gain plot is presented as Channel A and the phase plot replaces Channel B. Gain is plotted
in either dBs or in linear units of gain depending on whether you have selected Display in dBs or
not (also in the Settings menu, see below). The phase plot is presented in degrees or radians
dependant on Convert to degrees.
degrees
Phase is plotted between -180 degrees and +180 degrees. To avoid discontinuities at 180
degrees ( radians) phase can be plotted between 0 and 360 degrees if Unwrap Phase is
selected.
FFT window controls which windowing technique is used. Fourier analysis makes the
assumption that the sampled section of a waveform as captured in a frame is repeated infinitely
both forward and backward in time. Using the special case of a sine-wave to illustrate the point,
a captured sine wave will not necessarily finish in the frame at the same point in its cycle that it
started.
Assuming that such a frame is repeated endlessly will therefore add discontinuities where the frames join that are not actually
present in the real signal. These discontinuities are called end-point errors and they are common to all Fourier Transform
Analysers. Windowing is a mathematical technique used to minimize such end-point errors.
The choices of windowing techniques in Cleverscope are:
• None
• Hanning
• Hamming
• Blackman-Harris
• Exact Blackman
• Blackman
• Flat Top
• 4 Term B-Harris
• 7 Term B-Harris
• Low Sidelobe
Cleverscope CS328A User Manual
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These windows have the following characteristics:
Window

-3 dB Main -6 dB Main Lobe
Lobe Width
Width (bins)
(bins)

Maximum Side
Lobe Level
(dB)

Side Lobe RollOff Rate
(dB/decade)

Uniform (None)

0.88

1.21

-13

20

Hanning (Hann)

1.44

2.00

-32

60

Hamming

1.30

1.81

-43

20

Blackman-Harris

1.62

2.27

-71

20

Exact Blackman

1.61

2.25

-67

20

Blackman

1.64

2.30

-58

60

Flat Top

2.94

3.56

-44

20

The choice of window to use depends on the type of signal being examined, and the desired trade off between Frequency
resolution, spectral leakage and amplitude accuracy.

The following table gives a first approximation to the best type of window to use:
Signal Content

Window for best
frequency
resolution

Window for best
spectral leakage

Window for best
amplitude accuracy

Sine wave or combination of sine
waves

Hanning

Exact Blackman

Flat Top

Narrowband random signal (vibration
data)

Hanning

Blackman Harris

Blackman Harris

Uniform (None)

Blackman

Uniform

Uniform, Hamming

Hamming

Blackman

Broadband random (white noise)
Closely spaced sine waves
Excitation signals (Hammer blow)
Unknown content

Uniform (None)
Hanning

4.5.3.7 Averaging
Averaging can be used with either the Spectrum Graph or the Scope Graph/Tracking
Graph Tracking Graph.
Graph A
number of frames can be arithmetically averaged together to reduce the effect of noise.
Averaging is usually used to minimize the effects of noise and to find the average value of a
signal in the presence of noise.
Weighting mode provides three types of averaging; Linear,
Linear Exponential,
Exponential and Peak.
Peak Peak
averaging can only be applied to the Spectrum Graph.
Graph
Linear does averaging with equal weighting. It sums a number of captured frames and then calculates a new frame which is
the average of them all. The number of frames being averaged may be set in Number of averages.
averages
If 16 frames are being averaged then a new frame is displayed only after 16 frames have been captured, transferred and
averaged. Triggering can be used to ensure that all of the averaged frames are aligned with respect to the cycle of the
captured signal.
With Exponential averaging the PC calculates the average for a new frame every time a frame is captured and transferred
from the acquisition hardware. Automatic frame capture, triggering and frame transfer will continue to work as it does
without averaging. As for Linear averaging, triggering can be used to ensure that all of the averaged frames are aligned with
respect to the cycle of the captured signal.
Older frames contribute less than more recent frames to each calculated average. The contribution of a frame to each new
calculated average diminishes exponentially with time as new frames are transferred and new averages calculated. The
contribution of older frames to the most recently calculated average is never lost however (unless averaging is turned off or
reset).
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Let N represent the Number of averages when exponential averaging is selected. The value of a sample in a newly averaged
frame is calculated as follows:
The value of a sample in a new frame is added to N-1 multiplied by the value of the equivalent sample in the last ‘averaged’
frame and the total is divided N.
Vnewcalc = (Vnew + (N-1)Vpreviouscalc)/N
Where Vnewcalc, Vnew, Vpreviouscalc, all represent samples which are in equivalent positions in a frame with respect to time and:
Vnewcalc is the newly calculated average for a sample.
Vnew
is the most recently measured and transferred value for the equivalent sample.
Vpreviouscalc is the previously calculated average for the equivalent sample.
This form of averaging is called exponential averaging because the weighting given to each frame of samples, as you go back
in time, represents an exponentially decaying curve. If N is 4 the weighting given to the samples in each frame going from the
most recent frame backwards is represented by the following series:
V11/4, V2 3/16, V39/64, V427/256, V581/1024 …
Where V1 is the amplitude of a sample in the most recent frame and V5 is the amplitude of the equivalent sample in the 5th
most recent frame.
Peak averaging can be used in a situation where you want to accumulate in one spectrum the maximum frequency points
from the spectra of a number of frames. Peak averaging can only be used to accumulate the peak frequency levels from
consecutive spectra and is not relevant for use in the time domain.
When Peak averaging is used the spectrum of a frame of signal data is calculated and the frequency points are saved in an
averaging array. When the frequency points of a newly captured frame are loaded into the averaging array only those points
whose levels are both greater than their counterparts in the current array are actually loaded. In this way all the frequency
points in the peak averaging array represent the greatest levels so far recorded at those points.
Peak averaging is very useful if you are doing Gain/Phase plots. Instead of using a white noise generator to produce an input
signal that contains all the frequency points of interest in one frame, a sweep frequency signal generator can be used to build
up the gain and phase response of the system over a number of frames.
Note The choice of Number of averages is not relevant for Peak averaging.

Averaging in the Scope Graph
Graph
If you wish to do time averaging, you must have a periodic waveform whose phase variation is relatively stable so you
achieve a stable trigger.
Use equal averaging when all frames are equally important (a periodic waveform with noise, for example). Use exponential
averaging when you wish to get the best estimate of the current value of a varying signal (for example a pulse train with
jitter).
Averaging in the Spectrum Graph
If you wish to do frequency domain averaging then you should be aware of the difference that Triggered and Auto frame
capture has on averaging. If Triggered has been selected, Cleverscope assumes you have a periodic waveform and a good
trigger, and averaging will be performed in the time domain, before transforming the resulting average to the frequency
domain. If Auto is selected, the signal data is transformed and the averaging is performed in the frequency domain.
Use Triggered when you have a stable periodic signal with impressed random noise. Use Auto when the signal is not periodic
and a stable trigger is not available. When Auto is used (and averaging is done in the frequency domain) endpoint errors will
be smoothed as they will have different frequency content from frame to frame. End-point errors are discussed under
‘Windowing’ above.
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4.5.3.8 Reset Average
Reset Average restarts any averaging process that may be underway. The averaging process that is currently selected will
start again when the next frame is captured.

4.5.3.9 Display in dB
When Display in dB is selected then the vertical axis of the Spectrum Graph will be displayed logarithmically in dB as opposed
to a linear amplitude scale. The exception to this is the Phase plot when Gain/Phase is selected for the Spectrum Graph
because phase is always graphed in degrees or radians.

4.5.3.10 Display spectrum log frequency
When Display spectrum log frequency is selected then the horizontal axis of the Spectrum Graph will be displayed
logarithmically as opposed to a linear frequency scale.
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4.5.3.11 Calibrate Cleverscope
Standard self calibration should be executed if the temperature changes by more than
10°C. Cleverscope includes an internal reference which is used to self calibrate all the
analog circuitry within the Cleverscope Acquisition Unit.
Unit Before initiating a Standard self
calibration, disconnect all probes from the front of the Cleverscope Acquisition Unit and
ensure that it has been powered up for more than 5 minutes, then click Start Self
Calibration.
Calibration The self calibration process takes about 7 minutes.
The Signal Generator calibration only needs to be done once after you install the optional
Signal Generator Unit yourself. If your Cleverscope Acquisition Unit came with a Signal
Generator Unit installed then this calibration will have been completed at the factory.
Before initiating a Signal
Signal Generator calibration, connect a lead from the Signal Generator
output to the Chan A input, and then click Start Sig Gen Calibration.
Calibration
The Once Yearly calibration requires a high precision reference of around 2 V. You must
know the reference output voltage with an accuracy of at least 1 mV to guarantee proper
calibration. Before initiating a Once Yearly calibration, disconnect all probes from the front
of the Cleverscope Acquisition Unit and ensure that it has been powered up for more than
5 minutes, then click Begin baseline measurement and follow the instructions. A Once
Yearly calibration should always be followed by a Standard self calibration.
The Ext Trig and Digital Inputs calibration only needs to be done once. If the thresholds for
the external trigger or digital inputs are not responding correctly then perform the
appropriate calibration. Earlier versions of the Cleverscope acquisition unit may not have
had this done at the factory.
The Frequency Response calibration is completed at the factory. If you think there is a
problem with the frequency response of your Cleverscope Acquisition Unit,
Unit contact
Cleverscope support before carrying out a Frequency Response calibration.

4.5.3.12 Colours
Colours lets you select different colours for graph plotting. You can select colours for channel A
plotting, channel B plotting, graph backgrounds, and major and minor grid lines.

4.5.3.13 Display tool tips
Display tool
tool tips allows you to select whether the tool tip pop-ups show when you hover over
an item with the cursor.
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4.5.4 View Menu
Various windows can be selected for display under the View menu. The operation of
each of these windows is discussed in the following section.
Note The Digital Graph is not a window in its own right, but is built into the Scope or
Tracking Graph.
Graph It can be de-selected to save screen space.
When Tracking Graph is Linked is selected the tracer in the Scope Graph will mimic the
tracer in the Tracking Graph,
Graph and vice versa. The Tracking
Tracking Graph time axis will change
to keep the tracer in the centre of the graph. If the Tracking Graph is not linked, the
two graphs can be manipulated independently of each other.

4.5.5 Window Menu
The Window menu is used to select which of the displayed Cleverscope windows you
wish to be currently active. A window can also be made active by simply clicking inside
it, but this presumes that it is visible, or in front on the desktop.
Note A window will only appear in the Window menu if it is currently selected to be
displayed in the View menu.

4.5.6 Help Menu
About Cleverscope shows the various keyboard shortcuts and the current version
number of the Cleverscope Application software. About DDE links shows how to link
live data from Cleverscope to other applications such as Microsoft Excel or Access. End
User License shows your license agreement.
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5 Scope Graph
The Scope Graph is used to view captured signals in the time
domain, and to determine the boundaries of the signal to be
captured in both amplitude and time. It is divided into three
areas; the Information area at the top, the digital graph in the
middle and the analogue scope at the bottom.
Viewing the signal on the Scope Graph is like viewing a signal on
a normal oscilloscope. The channel A and B signal traces are laid
over each other and visible in the same window as they are in an
oscilloscope. As with an oscilloscope both channels A and B are
referenced to the same horizontal time axis but each has their
own vertical or voltage axis.
As with an oscilloscope, triggering can be used to ensure that
repetitive waveforms remain stationary on the Scope Graph as
frames are acquired and displayed on a continuous basis.
The Digital Graph for displaying the pulse trains present on each
of the 8 digital inputs is located above the main Scope Graph.
Graph Its
horizontal (time) axis is locked into the horizontal axes for the
Scope Graph below it and so the horizontal display controls for
the Scope Graph also apply to the Digital Graph.
Graph
Note To conserve display space the Digital Graph can be turned off in the View menu.

5.1

Vertical Axis

To the left of the A channel vertical axis are a number of buttons for controlling the vertical positioning and
scaling of the A channel signal data. The same buttons for the B channel are positioned to the right of the
vertical B channel axis.
Use the up arrow button ( ) to move a channels signal trace up. Similarly, use the down arrow button ( )
to move a channels signal trace down.
Use the auto-fit button ( ) to let Cleverscope decide and apply the optimum vertical scaling and
positioning for a channels signal data.
Use the vertical expand (
data.

) and contract (

) buttons to vertically expand or contract a channels signal

The zero button ( ) sets the amplitude axis so that 0V is at the vertical centre of the amplitude range.
Note The mouse scroll wheel will work on the last control used as a virtual knob.
The Scope Graph setup also determines how a signal will be captured. The vertical axis setup determines
the internal scaling and offset. Cleverscope’s full 10 bit analogue resolution maps onto the chosen
minimum and maximum amplitude axis values. The values for Channels A and B are independent of each
other.
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5.2

Horizontal Axis

Below the horizontal time axis are the buttons for
controlling the positioning and scaling with respect to
time of both A and B channel signal traces.
The left and right arrows (
and
) move the signal left or right in time. The horizontal contract (
buttons horizontally expand or contract the signal with respect to time.

) and expand (

)

Note The mouse scroll wheel will work on the last control used as a virtual knob.
The Fit ( ) button will let Cleverscope decide and apply the optimum position and scaling with respect to time for the Scope
Graph. The zero button ( ) repositions the graph so that zero time is in the centre.
The time axis determines the start and stop time of the signal captured relative to the trigger. The trigger position is always
time 0. Positioning the time axis so that the left hand side of the axis is negative means that you will see signal before the
trigger occurred. Similarly, positioning the left hand side of the time axis to be positive means that there will be a delay
following the trigger before signals are acquired and displayed.

5.3

Tracers and Markers

5.3.1 The Tracer
The tracer is a small black circle that can be moved along a signal trace using the mouse. The voltage
level and position in time is displayed in the Information area. By moving the tracer to a point of
interest on the signal trace or spectrum you can read the voltage level and time at that point.

5.3.2

Placing Markers

Markers are used to measure the time and amplitude of a time plot – or the frequency and amplitude
for a spectrum plot. You place markers like this:
1. Move the tracer to the location of interest.
2. Place a marker by either:
• double clicking
• pressing the space bar
• pressing the 1 or 2 keys
Up to 2 markers can be positioned in this way. The markers will always maintain their horizontal
positions on the signal trace. Their positions are displayed in the Information area.

5.3.3 Measuring Differences and Frequency
You measure differences by placing two markers, and then reading the differences in the right most
Information box. Here the time difference is 0.75 ms. You can measure differences between plots by
placing the first marker, and then pressing the Tab key to move from one plot to the next, and
placing the second marker.
Also displayed in the Information area are the differences in voltage and time (delta) between the two markers. The Freq
value is the inverse of the time delta.
Volts/Division and Secs/Division are displayed above the top left hand side
of the graph.

5.3.4 Digital Tracers and Markers
Notice that as you move the tracer, the black tracer line on the digital display follows the analog tracer. Similarly the markers
are mirrored to the Digital Graph,
Graph which is synchronized with the analog graph. If you want to pay particular attention to a
digital input, drag the threshold marker
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to the input of interest.
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5.4

Frame and Trigger Time Stamp

The Frame value gives the frame number for the currently displayed graph. The Trigger time stamp is maintained by the CAU,
as a 64 bit word with 10ns resolution (5,865 years). Each trigger is time stamped with the real time, to 10ns resolution. The
trigger time is displayed above the graph on the right, and is also used to time stamp the protocol decodes. In addition the
trigger time can be used by the Maths system to calculate the time difference between triggers. Any saved files (.apc and
text) are time stamped with the trigger time. You may need to drag the window wider to see the whole time stamp.

5.5

Graph Settings

There are a series of buttons between the graph and the information area that
control graph settings.
The Zoom In ( ) and Zoom Out ( ) buttons zoom in and out on both channels at the same time.
The Setup 1 (
setup 1 and 2.

) and Setup 2 (

) buttons restore graph setup 1 and 2. S hift + Setup 1 (

) and S etup 2 (

Previous Graph Setting ( ) button goes back to the previous graph setting and the Next Graph Setting (
forward to the next graph setting. The settings buffer can hold up to 50 previous settings.
The Tracer Cursor Style (
The Normalize Grid (

) save graph

) button goes

) button toggles between a dot and a line cursor.

) button normalizes the scales of the grid, so they line up.

The Knob Palette ( ) button turns the knob palette on or off. The knob palette appears in the left-hand side
of the Scope Graph as shown to the right.
Note The mouse scroll wheel will work on the last control used as a virtual knob.
The Y Coarse/Fine ( ) button and the X Coarse/Fine ( ) button toggle between coarse and fine movement
of the respective scales. When set as shown above, the movement is coarse which moves by a major grid scale
on each movement. When set as ( ) and ( ) respectively, the movement is fine which moves by a minor grid
scale (1/5th of the major grid) on each movement.

5.6

Zooming the Graph

You zoom the graph in these ways:
1. Use the graph enlarge/reduce tools to enlarge or reduce the graph. For the time axis, the contract button (
)
zooms out on the signal and the expand ( ) button zooms in on the signal. For the amplitude axis, the expand
button ( ) zooms in, and the contract button ( ) zooms out.
2. Use the Control Panel Tools
to zoom on time, amplitude or both.
3. Use the key commands to zoom on the tracer:
and
move the cursor left and right
Shift +
and
move the graph left and right
Ctrl +
and
change the x-scale up or down
and move the selected graph up and down
Shift + and move the selected graph up and down
Ctrl + and change the y-scale up and down

5.6.1 How Zooming Works
Cleverscope keeps all the samples in the acquisition unit. When you zoom the graph, the Cleverscope application requests a
new graph view from the acquisition unit. The acquisition unit finds the samples, and returns them, via the USB. The
acquisition unit can keep up to 2 or 4 M samples in any one display buffer (for the 4M and 8M models).
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6 Tracking Graph
Use the Tracking Graph together with the Scope Graph to have both an overview of
the entire frame of signal data and a close-up view of a portion of the signal trace that
interests you.
First ensure that you have turned on the Tracking Graph display and that the Tracking
Graph is Linked using the View menu. As you move your mouse along the signal trace
in the Scope Graph,
Graph the Tracking Graph window will also move giving a close-up view
of the signal centred on the position of the tracer in the Scope Graph.
Graph The tracer
positions in both graphs will refer to the same point.
The Tracking Graph works in an identical fashion to the Scope Graph.
Graph Zoom, pan and
annotate in exactly the same way. The Tracking Graph has its own markers and
annotations.
As you move the mouse/tracer outside the current window view in the Scope Graph,
Graph
the tracking window will move to accommodate the new tracer position. This ensures
that the tracer is always in view.
As with the Scope Graph,
Graph when Display
Display Digital Graph is selected on the View menu,
the Tracking Graph also displays the Digital Graph.
Graph
There are many occasions where you find a feature of interest in the Scope Graph,
Graph and
wish to examine it more closely. To do this, position the tracer on the feature in the
Scope Graph,
Graph type ‘L’ to temporarily lock the Tracking Graph position. You can now
manipulate the Tracking Graph view. Clicking on the Tracking Graph will clear the lock.
As with the Scope Graph,
Graph the Tracking Graph also has an Information area displaying
information about the position of the Tracking Graph tracer, markers, marker
differences and signal frequency.
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7 Spectrum Graph
The Spectrum Graph displays the Fourier transform of the channel A and channel B
signal data. The Source for the Spectrum Graph can be selected from the Scope,
Scope
Tracker or Maths graph.
In addition to the graph setting buttons that appear on all graphs (see the Graph
Settings section above), the Spectrum Graph has two additional buttons and two
additional frequency selection lists.
The Set Chan A peak to 0 dB ( ) and Set Chan B peak to 0 dB ( ) buttons toggle
between setting each channels peak value as displayed on the graph to 0dB or not. The
channel A button is shown in the set peak to 0 dB position and the channel B button is
in the normal position.
Frequency Span and Frequency Res controls the spectrum analysis frequency span and resolution displayed in the Spectrum
Graph.
Graph The resolution is increased by increasing the number of samples returned from the capture unit to the spectrum
analyzer.
There are four choices of Fourier transform. On the Settings
Settings menu, click
Spectrum. The Fourier Transform Type can be:
Spectrum
• RMS Amplitude
• Power
• Power Density
• Gain/Phase
The windowing technique can also be selected as follows:
• None
• Hanning
• Hamming
• Blackman-Harris
• Exact Blackman
• Blackman
• Flat Top
• 4 Term B-Harris
• 7 Term B-Harris
• Low Sidelobe
Fourier transforms and windowing techniques are discussed in detail in the
Spectrum section of the Settings menu description above.
As with the Scope Graph and Tracking Graph,
Graph the display controls for the
Spectrum Graph work the same way, except that the horizontal axis
represents frequency instead of time.
A tracer may be moved along the spectrum trace in the same way as the
Scope Graph.
Graph Markers may be placed on the spectrum trace at points of
interest by double clicking at the desired tracer position.
The Information area displays information about the position of the tracer,
the markers, the amplitude and frequency differences between the
markers and the inverse frequency difference between markers, labelled as
time.
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8 Signal Information
Information about Channel A and B signal data is displayed in the Signal
Information window. The results of a number of mathematical functions are
displayed in a table.
The information is calculated using the source graph specified by the Information
Source,
ource, located at the bottom right of the Signal Information window. Click on the
button to choose the source. The values are calculated using the signal displayed
on the graph.
You can use the Tracking Graph to derive information over a smaller time period,
and by linking the Tracking Graph to the Scope Graph
Graph,
raph and selecting the Scope
Graph, and moving the mouse over the graph, trace variations in value such as
Frequency, DC or RMS. Data is only updated if the source graph is open.
All the results can be averaged by turning Averaging on.

8.1

DDE Links

DDE enables Cleverscope to emit DDE (Dynamic Data Exchange) messages to any
application that can subscribe to DDE links. These are useful for embedding live
data in Excel or Access. Links are updated by default as real format numbers with
8 decimal digits. DDE is only output when the Signal Information is displayed. To
stop/start updating the DDE links, click DDE.
DDE
On the Help menu, click About DDE Links for more detail. You can copy and paste
a link directly from the help dialog into your receiving application. As the signal
information can have the Maths graph as a source, derived maths values can be
linked via the DC or Marker X, Marker Y values.
DDE uses three values to specify the source:- the Service name (which is Cscope),
the Topic name (which is Info) and the item name. For Excel a typical link might
be
=Cscope|Info!A_Freq which displays the Frequency of Channel A in the
spreadsheet cell. Make sure Cleverscope is running before opening the
spreadsheet.
Here are the available items:
Time Information
=Cscope|Info!A_V_DC
=Cscope|Info!A_V_RMS
=Cscope|Info!A_V_Max
=Cscope|Info!A_V_Min
=Cscope|Info!A_Pk_Pk
=Cscope|Info!A_Std_Dev
=Cscope|Info!A_Period
=Cscope|Info!A_Freq
=Cscope|Info!A_Amplitude
=Cscope|Info!A_Pulse_Len
=Cscope|Info!A_Duty_Cycle
=Cscope|Info!A_VMarkerT
=Cscope|Info!A_VMarkerV

Spectrum Information
=Cscope|Info!A_F_DC
=Cscope|Info!A_F_RMS
=Cscope|Info!A_Fsignal
=Cscope|Info!A_Vsignal
=Cscope|Info!A_HF1
=Cscope|Info!A_HV1
=Cscope|Info!A_HF2
=Cscope|Info!A_HV2
=Cscope|Info!A_HF3
=Cscope|Info!A_HV3
=Cscope|Info!A_Sinad
=Cscope|Info!A_THD
=Cscope|Info!A_HV2_HV3
=Cscope|Info!A_FMarkerF
=Cscope|Info!A_FMarkerV

Examples:
=Cscope|Info!A_V_DC
=Cscope|Info!B_HF1
=Cscope|Info!A_VMarkerV
=Cscope|Info!B_FMarkerF

Display A channel DC volts
Display B fundametal frequency
Display Marker 1 volts
Display Marker 2 frequency

Item names are preceded by either A_ or B_ to define which channel is being used. Marker 1 is A_ and Marker 2 is B_.
B_
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8.2

Logging

Clicking Show Logging expands the window
to show all the logging functions so that
available signal information can be logged.
Select the items to be logged in Log
Function? and select to Log Channel A? and
Log Channel B?.
B? Choose a Log File Type of
Text File or Excel File. If Excel File is selected,
also click Select Sheet to choose whether the
data is logged in a New sheet or the First
sheet. Enter a Log File Name including its
path or click
to browse to a file. The
logging system can open Excel 2000-2007
and log directly into the spreadsheet.
If a Log File Type is Text File, you are also able to open the file in the standard Scope Graph and see the first two channels of
captured data (use Auto Fit to size the signal to the display). The saved data includes the 10ns trigger time, which means the
log file can be used to find the exact duration between trigger events.
The Update Interval includes the value 0. This means save every trigger, which can be used for saving at maximum rate or for
sporadic sampling where a trigger only occurs occasionally. An added bonus is being able to see as much of the captured file
as you wish while capturing is happening.
Click Start Logging to start and stop logging. Click Pause to take a break in the logging and click it again to resume logging.
The logging will halt when the Number saved to the log file reaches the Number of values to save.
save
Similarly to DDE,
DDE if the Information Source is Maths then derived values can be logged via the DC, etc or Marker X, Marker Y
values.
The Log display graph automatically adapts itself to the number of items selected to be displayed.

8.3

Signal Information Descriptions

DC is calculated by taking the mean amplitude value of the signal data (either full frame or between tracking markers). It
represents the DC offset of the signal data for which it was calculated.
RMS (root mean square) is calculated by squaring the value of each sample, taking the mean value of these squares; and then
taking the square root of this mean value. As for all functions the calculation is either done for the entire frame or between
the tracker markers.
Max (maximum) is simply the maximum value of all the samples within the range specified.
Min (minimum) is the minimum value of all the samples within the range specified.
PkPk-Pk (peak to peak) is calculated by taking the difference between the minimum value and the maximum value within the
sample range specified.
The Period is calculated by finding the mid level crossings, and estimating the time between crossings. A hysteresis approach
is taken to finding the mid level crossing point to avoid the effects of overshoot and ringing.
The Fundamental Frequency for the highest amplitude component chosen is displayed from a Fourier transform of the signal.
The Fundamental
Fundamental Peak amp for the highest amplitude component chosen is displayed from a Fourier transform of the signal.
To calculate Pulse Length Cleverscope assumes that the signal is repetitive. The pulse length is calculated by finding the mid
level crossings and calculating the time difference between the positive going crossing and the next negative going crossing.
To calculate Duty Cycle Cleverscope assumes that the signal is repetitive. The duty cycle is calculated by taking the time at
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which three consecutive mid level crossings occur. The duty cycle is percentage ratio of the time from the first rising mid level
crossing to the next falling mid level crossing divided by the time from the first rising mid level crossing to the next rising mid
level crossing.

8.4

Spectrum Information Descriptions

DC is calculated by taking the mean amplitude value of the signal data (either full frame or between tracking markers). It
represents the DC offset of the signal data for which it was calculated.
RMS (root mean square) is calculated by squaring the value of each sample, taking the mean value of these squares; and then
taking the square root of this mean value. As for all functions the calculation is either done for the entire frame or between
the tracker markers.
Fsignal is the frequency of the signal estimated to be the largest frequency component.
Vsignal is the amplitude of the signal estimated to be the largest frequency component.
F1 is the frequency of the fundamental signal.
V1 is the amplitude of the fundamental signal.
F2 is the frequency of the 2nd harmonic of the fundamental signal.
V2 is the amplitude of the 2nd harmonic of the fundamental signal.
F3 is the frequency of the 3rd harmonic of the fundamental signal.
V3 is the amplitude of the 3rd harmonic of the fundamental signal.
SINAD is Signal in Noise and Distortion. It is the ratio of signal plus noise plus distortion and noise plus distortion.
THD is Total Harmonic Distortion. It is the ratio of the sum of the powers of all harmonic components to the power of the
fundamental frequency.
HD2+3 is the ratio RMS sum of the 2nd and 3rd harmonic referred to the fundamental amplitude.

9 XY Graph
The XY Graph displays the XY plot of the channel A and
channel B signal data.
In addition to the graph setting buttons that appear on all
graphs (see the Graph Settings section above) the XY
Graph has one additional control. The XY Source controls
the source data from the Scope,
Scope Spectrum,
Spectrum Tracker
Tracker,
er or
Maths graph.
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10 Protocol Decoder and Setup
The protocol decoder is capable of decoding SPI, I2C, and
RS232/422/485 serial data (UART). In addition a counting
decoder is provided for a collection of data lines. The decoders
are configurable for number of bits, data sense, bit order, chip
select active level, and the source for each decoder input. Any
CS328A signal (In1
In1-8
A Chan B,
B and Ext Trig)
Trig can be used
In1 8, Chan A,
as a source. The threshold level used for analog sources is
configurable. The colour used to display the symbols is
configurable.
Up to 4 decoders can be used at any one time. Decoder results
can be displayed as Characters, Decimal numeric and
Hexadecimal numeric. Each decoder outputs to one line on the
Digital graph. Decoded symbols are positioned starting at the first
bit of the decoded symbol if the display time base allows. If the
timebase is zoomed out, decoded symbols are compressed
together. Each decoder can be assigned a name. If the decoded
output is displayed as characters, non printing characters are
displayed as ‘.’ Newlines are output correctly.
Decoded results can be automatically copied to the Notes display by selecting Copy to Notes,
Notes allowing captured strings to be
copied and pasted into other applications. Decoded symbols are compressed to a single string, if the inter character time is
less than three character durations. Each decoded string includes the time at which it occurred, with 10ns resolution. Using
Notes,
Notes and an Excel spreadsheet, it is easy to measure the time between messages.
The I2C decoder uses colour highlighting to show the address, data, start, stop, ack and fault/non fault status.
The protocol decoder works over both regular captures (automatically improving sample resolution if required), and over full
buffer transfers. A full buffer (4M) capture of 2 seconds will have 500ns resolution, still sufficient to decode 400 kHz I2C,
115 kbaud serial, and 500 kHz SPI. 2 seconds of transfer represents a message of about 100,000 I2C characters, 23,000 serial
characters or 125,000 SPI characters if transmitted at full rate.
Decoded messages are automatically saved in the .apc file when saved, allowing the captured signal and decoded message to
be viewed using the Cleverscope application – useful for sharing via a network, email or later review.
If the display width chosen on the Scope Graph results in a resolution that doesn’t show the individual bits of the signal then
the protocol can not be decoded or displayed. However, clicking Get Frame should be able to decode it because the data will
be brought in at a higher resolution.
In addition the decoders work on a frame by frame basis. The current frame is set using Current Frame on the Cleverscope
Control Panel.
Panel Changing the current frame allows reliable navigation and display of each frame contents. If the protocol
decoder is enabled, as each new frame is displayed for the first time, the frame is decoded, and optionally added to the
Notes.
Notes
This capability means that multiple short messages can be captured and displayed and decoded, without capturing the
intervening dead space. For example to record the first 50 messages being sent, set the number of frames to at least 51, and
the number of frames per capture to 50. (Use Acquisition Settings on the Settings
Settings menu). Click Single (assuming you have set
up the trigger beforehand), and the next 50 messages will be captured. You can now use Current Frame to navigate each
message. As the frame is loaded, it is decoded, and the message added to Notes,
Notes if Copy to Notes is enabled. Inter message
time can be as short as 20us.
Here is an example of the output of the protocol decoder being copied into the Notes window:
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The first line gives the name of the decoder, and the frame that was decoded (you can decode up to 3000 sequential
frames), and the trigger time with 10ns resolution.
Subsequent lines show for that frame, each decoded chunk of text (text is grouped if the char-char time is less than 3
character times). The decoded chunk is preceded by the time relative to the trigger.
As further frames are decoded, they are sent to the Notes.
If you copy and paste the decoded text into Excel, you get this:

The copy includes tab characters, so that the columns line up well.
The following pages show example Protocol decode setups, and the resulting decode.
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10.1 I2C protocol
2

Here is the scope graph displaying the colour coded I C decode:

If there is room, the symbol is positioned at the correct time position on
the signal. Values can be displayed in char, hex and decimal. The
address (shown in green) is always displayed in hex or decimal. The start
condition is denoted with an orange ‘s’. The stop is shown with a blue
‘p’. A repeated start is shown as sR. Acks are not shown. Nacks are
shown as a red ‘k’. Extended addressing is supported, displayed as
yellow extended address values.
Once captured, you can zoom on any symbol. If there is insufficient room, symbols are concatenated:

In this example the second message was extended, had repeated start, and ended with a Nack. The whole message is shown
in red as a result. Zooming in shows the individual symbol colours and positions:
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10.2 UART protocol
Here is the scope graph displaying the UART message.

The Protocol setup screen:

The source for each data line can be any one of the Digital Inputs 1-8, the external trigger, or Chan A or B.
If Chan A or B are used, you can set the threshold (or where there are two or more inputs, the threshold for each one of
them). The Uart decoder allows you to choose the number of bits, if parity is used, the bit order, and the idle state, in
addition to the bit time. A calculator for presetting the bit time with standard Baud rates is included. Otherwise you can just
type in the time (as we have here – 10usecs).
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10.3 SPI Protocol
Here is scope graph displaying the received SPI message:

The data line has been connected to both Input 1 and also Chan A.
The protocol setup shows that Chan A was used as the Data source:

As an analog channel was used, the signal will have been thresholded at the given Analog Threshold (2V).
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11 Maths
11.1 Maths Graph
The Maths Graph displays the results of the Maths Equation Builder.
Builder
In addition to the graph setting buttons that appear on all graphs (see the Graph Settings
section above) the Maths Graph has one additional control. The Maths Source controls the
source data from the Full Buffer,
Buffer Scope,
Scope Spectrum,
Spectrum or Tracker
Tracker graph. Note that Maths
works on the Spectrum Graph in the frequency domain. Also if full frame is selected and
there is not a full frame then it will just use the Scope graph data. Get Frame will
recalculate the maths using the full buffer. After a full frame transfer using Get Frame, you
can zoom in on the signal as normal. If a full frame is not used, zooming is limited by the
Scope Graph time resolution.
The Trigger time can be used by the Maths system to calculate the time difference
between triggers.

11.2 Maths Equation Builder
The Maths Equation Builder is used to build equations that process the available
analog and digital inputs to generate an output that goes into the channel you
choose. You can have up to 8 equations active at one time.
To create an equation, click on the Equations row you wish to edit. You can enter
equations two ways:
1. Type in the equation directly. To check that it is valid click on the Check
LED. A red LED means an invalid equation.
2. Build up the equation by clicking on the Channels,
Channels Operators or Numbers
buttons. If you want to use a function click on the Functions drop-down
button, and select the right one. Click Add to enter it into the equation. Use
the Backspace or Clear buttons to edit the equation. The equation will be
checked as you go.
Equations work on each individual sample in the channel signal, from beginning to
end. Channel signals a-d
d are the analog channels A-D, i1-i8
i1 i8 are digital input
channels 1-8 and x is the external trigger. Note: You must enable digital graphs if
the equations contain i1-i
i1 i8 and x , otherwise the equations won't work. Intermediate
results (even digital ones) are kept as real numbers.
Click Used?
Used? to enable and disable the equation.
Choose an output process. These processes combine the results of previous samples to determine the next value. The process
---->
> just transfers the data to the desired Destination channel.
---Choose the Destination channel. Channels c and d are useful as intermediate storage.
Digital values remain as real numbers until transferred to a digital input, at which point values >0 become true, and values
<=0 become false.
The equations are evaluated from top to bottom. Outputs from an equation are used as inputs to the next equation.
Examples:
Equation
-a
a+b
a*d
sign(-(abs(a-b)-8.5))
c:a
b:1
48

Process
----->
----->
----->
----->
A:B Phase
A:B Sig Gen

Result
Inverts a
Adds a and b
Multiplies a and d, e.g. Power = volts x amps
Returns 1 if the difference between a and b is <8.5, otherwise -1
Returns Phase (in degrees) between c and a
Sets the Sig Gen frequency to value given in b
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Click Apply Equations once you are happy with them. Any invalid equations will not be activated.
Click Set Filter 1 and Set Filter 2 to setup the filters applying to the Filter 1 and 2 processes.
You can get help on a process by selecting it at the bottom of the window and a process description will appear in Process
Help. In the descriptions, samples means the output of the preceding equation, output into A (if an A:B pair is used).
Help
The Maths system has a large number of processes. These processes are:
Integral, Differential, Filter 1, Filter 2, Values >0?, DC, Average, Std Dev, RMS, Pk-Pk, Minimum, Maximum, Freq
(Amax), Amax (Fo), Phase (Fo), Period, Duty Cycle, Pulse Width, Undershoot, Overshoot, Slew rate, A:B Pwr Factor,
A:B Phase, A:B Pwr Watts, A:B VA, A:B Var, A:B A leads B?, A:B Seq Integral, Seq Time Diff, A:B Interleave, A:B Sig
Gen, A:B Autosave
Help for each process is included in the Maths equation
equation builder.
builder Extended signal information is included in the processes.
Of particular note are the Values >0?,
>0? A:B Sig Gen and A:B Autosave processes. The Values>0? process yields all 0 if no value
is >0, and 1 if at least one value is >0. This process can be used to check if any value exceeds a threshold. For example say we
were trying to find out if the peak voltage ever exceeded 260V.
We would use this maths equation:
a-260
values>0?
b
- b would now contain 1 if any value was
>260V, otherwise 0.
A:B Autosave can be used to save a graph if any value in A is >0. The current Autosave setup is used. This can be used to log
out of range events.
(a-260):1
A:B Autosave b
- saves Scope graph if any value in a is >260V. b will contain 1 if we
saved, or 0 if we did not
A:B Sig gen can be used to set the sign gen to a frequency, amplitude, or waveform.
Freq(Amax):1 A:B Sig Gen
b
- sets the Sig Gen to output (i.e. track) an input signal. The frequency
output is saved in b.
This example can take a square wave input (or anything else for that matter) and produce a tracking generator, outputting a
sine wave of the fundamental frequency. This could be useful for waveform clean up, transfer functions, making a VCO, etc.
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11.2.1 Maths Equations Operators and Functions
The Maths equation editor supports the + - * / ^ ( ) operators.
The : operator is a special operator that is used to separate the two values that are used by some processes.
It supports the following functions, which can be used to construct each Maths equation using the operators. Each operator
and function acts on the sample set point by point.
Function
ltz
lez
eqz
gez
gtz
sign
abs
acos
acosh
asin
asinh
atan
atanh
ceil
cos
cosh
cot
csc
exp
expm1
floor
getexp
getman
int
intrz
ln
lnp1
log
log2
rand
sec
sin
sinc
sinh
sqrt
tan
tanh
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Explanation
Returns 1 if value less than zero, otherwise 0.
Returns 1 if value less than or equal to zero, otherwise 0.
Returns 1 if value equal to zero, otherwise 0.
Returns 1 if greater or equal to zero, otherwise 0.
Returns 1 if value greater than zero, otherwise 0.
Returns -1 if value < 0, 0 if value = 0, +1 if value >0
Returns the absolute value of x.
Computes the inverse cosine of x in radians.
Computes the inverse hyperbolic cosine of x.
Computes the inverse sine of x in radians.
Computes the inverse hyperbolic sine of x.
Computes the inverse tangent of x in radians.
Computes the inverse hyperbolic tangent of x.
Rounds x to the next higher integer (smallest integer x).
Computes the cosine of x, where x is in radians.
Computes the hyperbolic cosine of x.
Computes the cotangent of x (1/tan(x)), x is in radians.
Computes the cosecant of x (1/sin(x)), where x in radians.
Computes the value of e raised to the x power.
Computes e raised to the x power minus 1 ((e^x) – 1).
Truncates x to the next lower integer (largest integer x).
Returns the exponent of x.
Returns the mantissa of x.
Rounds x to the nearest integer.
Rounds x to the nearest integer between x and zero.
Computes the natural logarithm of x (to the base of e).
Computes the natural logarithm of (x + 1).
Computes the logarithm of x (to the base of 10).
Computes the logarithm of x (to the base of 2).
Random number between 0 and 1 exclusively.
Computes the secant of x, where x is in radians (1/cos(x)).
Computes the sine of x, where x is in radians.
Computes the sine of x divided by x (sin(x)/x), x in radians.
Computes the hyperbolic sine of x.
Computes the square root of x.
Computes the tangent of x, where x is in radians.
Computes the hyperbolic tangent of x.
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11.2.2 Maths Equations Processes
The Maths Equation builder supports a number of processes which act on the full array of samples.
Process
----->
Integral
Differential
Filter 1
Filter 2
Values >0?
DC
Average
Std Dev
RMS
Pk-Pk
Minimum
Maximum
Freq (Amax)
Amax (Fo)
Phase (Fo)
Period
Duty Cycle
Pulse Width
Undershoot
Overshoot
Slew Rate
A:B Pwr Factor
A:B Phase
A:B Pwr Watts
A:B Pwr VA
A:B Pwr VAR
A:B A leads B?
A:B Seq Intgrl

Explanation
Transfers the samples to the output channel.
Integrates the samples with respect to time.
Differentiates the samples with respect to time.
Filters the samples using Filter 1. Click the Set Filter 1 button to setup the filter.
Filters the samples using Filter 2. Click the Set Filter 2 button to setup the filter.
Returns 1 if any samples are >0, otherwise returns 0
Returns DC value of the samples
Returns Average value of the samples
Returns Standard Deviation of the samples
Returns RMS value of the samples
Returns Peak to Peak value of the samples
Returns Minimum value of the samples
Returns Maximum value of the samples
Returns the Frequency of the highest amplitude frequency component (Fo)
Returns the RMS amplitude of the frequency component Fo.
Returns the starting phase of frequency component Fo.
Returns the period of the signal in samples. You need at least one cycle.
Returns the duty cycle of the signal in samples. You need at least one cycle.
Returns the hi pulse width of the signal in samples. You need at least one cycle.
Returns the undershoot of the signal in samples. You need at least one cycle.
Returns the overshoot of the signal in samples. You need at least one cycle.
Returns the slew rate of the signal in samples. You need at least one cycle.
Returns the ratio of the real power/apparent power (VA) assuming
A is current and B is voltage.
Returns the Phase, in degrees, between A and B. If +ve, A leads B.
Returns the Real Power, in watts, assuming A is current and B is voltage.
Returns the Apparent Power, in VA, assuming A is current and B is voltage.
Returns the Reactive Power, in VAR, assuming A is current and B is voltage.
Returns 1 if A leads B in phase, otherwise 0
Maintains the time integral over sequential captures. Calculates:

New Integral = Old Integral + Sample average value * (tn - tn-1)
Where tn is the current trigger time, and tn-1 is the previous trigger
time. All sample in B must be <=0 to run the integral. If any samples
are >0 then the integral is reset. You can have one separate integral per equation line.
Seq Time Diff
A:B Interleave
A:B Sig Gen

Returns the time difference between the current trigger time, and the
previous trigger time, with 10ns resolution
Interleaves A then B then B to return one sample set of twice the sample rate
and twice as many samples.
Sets the signal generator. A is the output value. B sets the function:

0 = no action, 1 = frequency, 2 = amplitude, 3 = DC offset, 4 = waveform type,
5 = sweep on/off.
Values (A) are in: Hz (Frequency); V (amplitude); V (offset);
0=sine, 1 = triangle, 2 = square, 3 = DC, 4 = Off ; 0 = sweep off, 1=on
A:B Autosave

If any samples in A>0, save a graph using Autosave (which needs to have been previously setup).
B selects which graph is autosaved:
0 means current display, 1 = Scope Graph, 2 = Spectrum graph, 3= Tracker Graph, 4 = Maths Graph.

Where you see A:B, A is replaced by an equation before the colon, and B is replaced by an equation after the colon.
Examples:
4*sin(a):i1
2:(a*d)/3
a:1
1:c
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11.3 Maths Equation Builder Walkthrough
The mathematical functions are very useful for visualising information that can be derived from the measured signals. This
section describes deriving first the differential voltage across a resistor, followed by conversion of that value to a current, then
using a multiply to derive power, and finally by integrating the power to measure energy.
Derivation is very useful in a number of other areas – for example using I and Q signals to demodulate base band signals,
using 4 quadrant multiplication to simulate modulation and investigate the resulting signal bandwidth, using filters to
estimate what the real world measurement of a conditioned sensor might be.

11.3.1 The Example
As an example consider power consumption measurement. Here is a typical example – a power supply delivers 9V to a
battery powered Unit Under Test (UUT). Our goal is to measure current, and power consumption, and arrive at the total
energy needs of the UUT. To do this we use a series resistor (it could be a DC capable current clamp) to measure the current.
Because the resistor is in the positive line we need to do differential measurements to see the current.
+9V
Power
supply
0V

1.4
A ohm

+
B
-

Unit under
test

Here is a graph captured from a typical UUT starting up, configured as in the diagram:
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11.3.2 Deriving Differential Voltage
Go to the Cleverscope Control Panel window.
1. On the View menu, click Display Maths Equation Builder to show the equation builder.
2. Type in and use the buttons to form:
This equation subtracts each sample value in channel B at a particular time, from the sample value in channel A at
the same time. Next it transfers it into channel A.
Channel B displays the actual voltage going into the UUT.
3. Click on Apply Equations to save the formula.
Go to the Cleverscope Control Panel window.
• On the View menu, click Display Maths
Maths Graph.
Graph
By using Maths,
Maths with A-B

A, we arrive at the following graph:

11.3.3 Deriving Current
We can see the current demand was initially high, and then fell back following startup. However it would be useful to have
this in mA.
From V = IR, and using a 1.4 ohm resistor, we can see that
I = V/R
= V x 1000 x 1/1.4 mA
= V x 714 mA
Go to the Maths Equation Builder window.
1. Enter equation as:
2. Click Apply Equations.
Equations
Go to the Cleverscope Control Panel window.
1. On the Settings menu, click Analog Names and Units.
Units
2. In the Maths Graph
Graph Units area, change A Units to mA and A Name to
Current.
3.

Click OK.
OK
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Note The units and names change immediately on the graphs and information areas:

The graph is much more useful now – we can read the current off directly. We see the following:
1. The peak current demand is 2366 mA.
2. The stabilized current demand is 615 mA.
3. The increased current demand lasts for about 5 ms.

11.3.4 Deriving Power
The B channel shows the actual voltage going into the UUT. Many battery modules are rated in AHr which is the design
continuous current consumption available for one hour of use. As an example a 9.6 V (8 cell) NiCad battery pack might be
rated at 700 mAHr meaning that after one hour of constant current drain of 700 mA, the battery terminal voltage will have
fallen to 80% of the full charge terminal voltage, and the battery will be nearly empty. When using a switch mode power
supply, we are more interested in the power consumption, because the current will vary with terminal voltage. Assuming a
straight line reduction in battery terminal voltage (i.e. an average of 90% of the fully charged terminal voltage), we can
estimate the energy content of the battery in Watt Hr (or Joules, with constant conversion), and use this to calculate actual
battery life.
For the battery above, the capacity is:
0.9 x 9.6 x 0.7 = 6 Watt Hour, or
0.9 x 9.6 x 0.7 x 3600 = 21.7 kJoule.
Go to the Maths Equation Builder window.
1. Enter equations as:

We include the *1000 because the current is in mA, and we want it in A to get W.
Note There are now two equations. The first puts the current into channel A. The second equation runs after the
first, and uses the new current values in A to calculate the power.
2. Click Apply Equations.
Equations
Go to the Cleverscope Control Panel window.
1. On the Settings menu, click Analog Names and Units.
Units
2. In the Maths Graph Units area, change B Units to W and B Name to Power.
3. Click OK.
OK
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Again we have used the Maths,
Maths first multiply B x A

B to get Watts in the B channel, and re-label the axis for power:

The peak power usage is 8W, while the normal power usage is 5W. If we ignore the initial power pulse, we could estimate
the battery life at 6/5 = 1.2 Hours.

11.3.5 Deriving Energy
If the power consumption is varying markedly, we could measure the actual energy consumption, by integrating the power
used over an appropriate period. This can be done with the integrating process applied in the Maths equation.
Go to the Maths Equation Builder window.
1. Enter equations as:

Note The Integral Process is now turned on.
2. Click Apply Equations
Equations.
quations
Go to the Cleverscope Control Panel window.
1. On the Settings menu, click Analog Names and Units.
Units
2. In the Maths Graph Units area, change B Units to J and B Name to Energy.
3. Click OK.
OK
Just to get a flavour, here is the graph above with an integral applied:
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The axis has been relabelled to Energy (J), and shows energy consumed since the start. We see the energy use between
Markers 1 and 2 as 142.4 mJ, over 29.76 ms, or 0.02976/0.1424 s/J. As a very rough estimate, battery life will be:
Life = 21700 (j) x (0.02976 /0.1424) (s/j) = 4,528 secs, or 1.26 hours.
You can see here the great flexibility and reduction in error that can be achieved by using the mathematical equations, and
custom units, to make the graphs far more meaningful than the raw measured voltages.

12 Notes
Notes can be added and displayed to accompany any
set of data readings in the Notes window. Any notes
you enter are saved with each APC data file.
If you click the Send to Notes LED on the protocol
display, any decoded protocol messages will be
automatically added to notes.
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13 Signal Generator Control
Cleverscope includes an optional direct digitally synthesised signal generator. The
signal generator synthesises sine, square and triangle waves, at a frequency between
0.002 Hz and 10 MHz. You can vary the amplitude over the range 0
5V p-p and
the offset over the range –4 + 4V.
The signal generator outputs samples at a 50 MHz rate and uses a 5th order
modified Chebychev reconstruction filter.
The Waveform Type can be sine,
sine triangle,
triangle square,
square DC,
DC or OFF.
OFF Amplitude and
Offset are adjusted using the red sliders or by typing a value in directly.
Base Frequency sets the minimum frequency. Freq Range sets the range over which
the Adjust
Adjust slider operates. Output Frequency displays the actual frequency that is
output, i.e. Output Frequency = Base Frequency + Freq Range x Adjust.
Adjust
The Sweep Method can be Single Freq,
Freq Sweep asynchronous,
asynchronous Sweep synchronous,
synchronous
or Sweep synchronous autostep.
autostep
When Single Freq is selected, no sweeping occurs. When Sweep asynchronous is
selected, frequency steps occur at strict fixed time intervals and are therefore
asynchronous with the sampling system. When Sweep synchronous is selected,
frequency is only adjusted between sample frames. Since this is synchronous with
the sampling system no smearing of the spectra will occur. Sweep synchronous
autostep is the same as Sweep synchronous only the Freq Step is determined by
Cleverscope to achieve the highest resolution for a Bode plot. Sweep Synchronous
will only step if there are triggered signals being captured.
The Sweep Action can be Sweep Up Once,
Once Sweep Up Continuous,
Continuous Sweep
Up/Down Once,
Once or Sweep Up/Down Continuous.
Continuous
When be Sweep Up Once is selected, the signal sweeps up the frequency range
from the base frequency once and then stops. When Sweep Up Continuous is
selected, the signal sweeps up the frequency range from the base frequency and
then starts again from the base frequency. When Sweep Up/Down Once is selected,
the signal sweeps up the frequency range from the base frequency and then back
down to the base frequency once and then stops. When Sweep Up/Down
Continuous is selected, the signal sweeps up the frequency range from the base
frequency and then back down to the base frequency and then starts again.
Freq Step controls the size of each step during a sweep. Sweep Time sets the total
time of the sweep. Start Sweep starts and stops the sweep. The Sweeping LED
indicates when a sweep is in progress. Other factors may alter the sweep time. For
example if the trigger rate is slow, and sweep synchronous is selected, it will not be
possible to complete the sweep in the time selected.
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13.1 Signal Generator Simulator
The Cleverscope signal generator provides built-in software generated signals for both the A
and B channels that can be used to demonstrate the capabilities of the Cleverscope application
software without requiring a Cleverscope hardware unit.
The Cleverscope Signal Generator control window enables you to alter the frequency,
amplitude and wave-shape for both channel A and channel B of the internally generated
signals. The signals are not output to real hardware.
The choices for wave-shape are sine, triangle, square and sawtooth. These choices can be
selected independently for channel A and channel B using the signal type selection boxes at the
top of the signal generator setup dialog box.
You can also add background noise and a DC offset to the generated signals to make them
more closely approximate real-world signals that might be captured using a hardware unit.
The amplitude of background noise can be adjusted using the Chan A or B noise selection
boxes.
The level of DC offset can also be adjusted using the Chan A DC offset or Chan B Noise offset
selection.
The offset and noise levels can be zeroed using the buttons provided at the bottom of the signal
generator setup dialog box.
Selecting B = A + B using the switch provided at the bottom right of the signal generator setup
dialogue box will cause the sum of the channel A and B internally generated signals to be
directed to channel B for display.

58

Cleverscope CS328A User Manual

14 Using the Ethernet Cleverscope
The Ethernet Cleverscope can be used on a 10/100 Mbit/sec Ethernet network. The Cleverscope Acquisition Unit (CAU)
includes an automatic sensing Ethernet connector that senses the speed (10 or 100 Mbit/sec) and automatically reverses Tx
and Rx if the Ethernet cable has been crossed over. No cross over cable is required for PC- CAU use. The CAU can be
operated with either a Fixed IP address, or as part of a DHCP network (Dynamic Host Configuration Protocol), in which case
the CAU automatically acquires an address in the correct internet protocol address range.
The simplest use is as part of a DHCP network. Most modern routers and all servers offer a DHCP server function.
You can also use Fixed IP (Internet Protocol) Addressing, which is useful when you do not have a DHCP server, or are
connecting to a remote CAU connected at some other location.
This document provides instructions on using the Cleverscope as part of a DHCP network, or in a fixed IP address network.

14.1 Using Cleverscope on a DHCP network
The Cleverscope CAU is set by default to work as part of a DHCP network. When it is plugged into a network, the two lights
on the Ethernet connector show status.
The Connected LED
LED shows that the CAU has connected to
the network. The Transmit/Receive LED
LED will flash
whenever packets of data are transferred. Once the CAU
has triggered, the Transmit/R
Transmit/Receive LED will flash once per
second, as the Cleverscope application polls the CAU to
make sure it is still connected.

Connected
LED

Looking at Ethernet
connector from rear of CAU

Transmit
Receive
LED

If the Connected LED
LED is not on, there is a problem, and the
CAU will not talk to the Cleverscope application. Please
resolve the connection first.

To use the Cleverscope carry out these steps:
1. Connect the Cleverscope to the network and turn it on. Make sure the Connected LED comes on.
2. On the Settings menu click Choose Acquirer and set connection to display the following dialog:
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Make sure the Type of Acquirer is Cleverscope. Set Interface Source to Ethernet – Find first IP address. This option
will find the first free Cleverscope available on the network.
3. You should see the Cleverscope listed under Cleverscope devices found.
found If the entry under DHCP is not Yes, address
acquired, select the line which corresponds to the Cleverscope you want to use, and then click Set auto addressing
(DHCP).
(DHCP) This will cause that Cleverscope to use the DHCP method of addressing. The DHCP column should change
to Yes, address acquired, after you have clicked the button.
4. Click OK.
OK The CAU should be ready for use – click Auto on the Cleverscope Control Panel to acquire a signal.
The next time you start up the CAU, and run the Cleverscope application, you do not need to do setup – the CAU
will automatically connect.

14.1.1 Other DHCP connection options
14.1.1.1 Connect by IP Address
The Cleverscope application can also connect to a particular CAU by IP address. DHCP is still being used to bring the CAU on
to the current network. DHCP has a ‘lease time’ which is usually quite a long time (weeks). Each time the CAU is reconnected
to the network, the lease is renewed. The lease is for a set IP (Internet Protocol) address that is supplied by the DHCP server.
This means once you use the CAU on a network, you can use its address to reliably connect to just that CAU.
To do this:
1. Set Interface Source to Ethernet – Find by IP address.
2. Select the unit you want to use under Cleverscope devices found,
found this will update Cleverscope acquirer
acquirer selected to
have the same IP address as the one you selected.
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Notice that Cleverscope acquirer selected has an IP address of .104. This is the same as the device selected from the
list.
3. Click OK.
OK From now on, the Cleverscope application will always connect to the Cleverscope with an address of .104.
Other Cleverscopes will be given different addresses by the DHCP server.

14.1.1.2 Connect by Serial Number
The Cleverscope application can be setup to always connect to a given serial number, regardless of the IP address. Setup as
follows:
1. Set Interface Source to Ethernet – Find by Serial Number.
2. Select the unit you want to use under Cleverscope devices found,
found this will update Cleverscope acquirer selected to
have the same Serial number as the one you selected.
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3. Click OK.
OK The next time you start the Cleverscope application, it will connect to the given serial number, regardless of
IP address.

14.2 Using Cleverscope on a Fixed IP network
For a fixed IP network, for example a CAU plugged directly into a laptop, you need to do a little more work. We will examine
two situations: the Cleverscope is plugged into a fixed IP local network; the Cleverscope application is connecting to a remote
Cleverscope at some other place.

14.2.1 Local Fixed IP network
For this network there is no DHCP server, and so someone will need to manually enter the IP address of each unit on the
network. All the units must be on the same ‘subnet’. The IP protocol subnet is the first three groups of digits in the IP address.
For example, for 192.168.1.104, the subnet is 192.168.1. For most circumstances all the computers and equipment
connected to the same network must have addresses starting with 192.168.1. The remaining value (104) is the unit address.
So let us look at an example of a Laptop and a CAU connected directly to each other with an Ethernet cable (because of the
Auto direction, it is not important if the cable is cross over or not).
The examples below are from Windows XP. The setup is similar in other operating systems.

62

Cleverscope CS328A User Manual

Click Start,
Start then Settings,
Settings then Control Panel.
Panel Open Network Connections:
Connections

Open Local Area Connection,
Connection and click Properties as shown on the right:

Scroll down until you see Internet Protocol (TCP/IP):
(TCP/IP)
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Double click on this entry. For a DHCP computer you will see:

Click Use the following IP address,
address and type in the IP Address that you want to use, and a S ubnet mask that encompasses all
units on your subnet. Use this example if you are not sure:

Click OK,
OK and close all the dialog windows.
Open the Cleverscope application:
1. On the Settings menu, click Choose Acquirer and set connection.
onnection
2. Connect the Cleverscope to the Laptop, and power up. If the CAU was setup for DHCP, it will not find an address,
and you need to set it manually. Note the CAU IP address is returned as 0.0.0.0 as there is no DHCP server. Also
note that the PC NIC (Network Interface Card) address is 192.168.1.2, which is what you chose above. If the PC
address is not on the same subnet (you didn’t program it for some reason) the cleverscope cannot communicate.
Make sure they are the same.
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3. Click on the appropriate CAU entry under Cleverscope devices found (CG4159 in this example). You will see the IP
address transfer to the Cleverscope Acquirer selected area. Note that Interface
Interface Source is set to Ethernet – Find by

Fixed IP address’

4. In Cleverscope acquirer selected area, type in the fixed IP address you want to give the CAU, and click Set IP address.
address
Note the CAU DHCP column changes from Yes, in progress to No, using static IP. You should see:
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Once you see that the address of the CAU has changed to what you programmed it to, we suggest you power it
down, and then up again – just to verify that the address and static IP usage are correct. Remember that the subnet
(the first three numbers of the IP address) must be the same for the Cleverscope, and the NIC address found (which
is the PCs address).
5. Click OK,
OK and then click Auto on the Cleverscope Control Panel to acquire a signal.
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14.2.2 Remote Fixed IP network
In this situation, you do not have a Cleverscope – it is located somewhere else, and you want to connect to it over the
internet. Your IT people will make a bridge from the CAU to a port on the internet connection point, and give you the
address. In this example the address is 60.234.234.7.
1. On the Settings menu, click Choose Acquirer and set connection.
connection

2. Set Interface Source to Ethernet – Find by IP address.
3. Enter the IP address.
address
4. Click OK,
OK and then click Auto on the Cleverscope Control Panel to acquire a signal from the remote Cleverscope.
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15 Cleverscope Support
The Cleverscope software has been developed by Cleverscope Ltd. as a tool for displaying and manipulating captured analog
electrical signals on a PC.
It can be set to work with a variety of other signal acquirers including the Strobes 901/901A Acquisition Units or an internal
soundcard.
If you are having problems, please contact us at:
Email

support@cleverscope.com

Phone

+64 9 524 7456

Mail

Cleverscope Ltd.
PO Box 26527
Epsom
Auckland 1344
New Zealand

15.1 Minimum PC Requirements
The minimum PC requirements to use the Cleverscope CS328A are a Pentium class computer with at least 256 Mbyte of
memory, running Windows 2000 or later.

15.2 Download and installation of software
You may download a copy of the latest Cleverscope application software from the Cleverscope website at
www.cleverscope.com. The following explanation is for Windows XP and the process will vary slightly for other operating
systems.
Visit the www.cleverscope site, and then go to the download page shown below.

Next you click on download Cleverscope.
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You will then be downloaded a zipped file which must be saved.

Choose the option of saving the zip file rather than opening it. In this example it has been saved on the desktop.

You then unzip the file and you will be presented with a Cleverscope folder containing a number of files. Double click on
setup.exe to run the Cleverscope installer
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The installer will create a Cleverscope folder in your program files folder and save a number of files into it. It will also create a
desktop icon and an entry in the programs menu under the windows

button.

You are then able to run a demonstration version of Cleverscope.
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16 Specification
16.1.1 Acquisition
Acquisition Modes
Acquisition Modes
Acquisition Rate to PC, via USB
Acquisition Rate, multiple frame

Sample, Peak Detect, Filtered, Average, Spectrum
Single Shot, Triggered, Automatic, Multiple Frame
5, 10, 20 Frames per second (if not limited by trigger rate, or capture time)
Continuous capture until buffer is full (3000 frames of 1300 samples)

16.1.2 Analog Inputs
Number
Input Coupling
Input Impedance, DC coupled, all channels
Probe Attenuation
Maximum Voltage between Signal and
Common at input BNC
Time delay between channels, typical
Channel to Channel Crosstalk, typical

2
DC, AC, GND
1 M ±2% in parallel with 20 pF ±3 pF
1X, 10X
300 Vrms (420V peak, duty cycle <50%, pulse width <100 ms)
For steady state sinusoidal waveforms, de-rate at 20 dB/decade above 100
kHz to 10 Vpk at 3MHz and above.
200 ps
-70 dB at 20 MHz, signal at 0.5 Full Scale.

16.1.3 Vertical
Digitizers
Full Scale Volts Range
Resolution
Position Range
Analog Bandwidth
Instantaneous Capture Bandwidth
Repetitive Sampling Bandwidth
Analog Bandwidth in Peak Detect Mode
Analog Bandwidth with Anti-Aliasing filter on
Analog Bandwidth with Moving average filter on
Lower Frequency limit, AC coupled
Rise time at the BNC, typical
Peak detect response
DC Gain accuracy
DC Measurement accuracy
Delta Volts measurement

10, 12 or 14 bit resolution
40 mV to 20V, 1X probe
0.1 mV, 100 mV Full Scale.
Full Scale Range as above moved anywhere in the range ±12.5V with
10mV resolution.
100 MHz, -3dB
20 MHz, with sin(x)/x interpolation
100 MHz, -3 dB
50 MHz
20 MHz
5th Order 0.5 dB passband ripple, 50 dB down at 100MHz.
2 MHz
10 Hz, 1x probe, 1Hz, 10x probe
<3 ns
Captures all pulses >10 ns in duration.
±3% for Sample or Averaged acquisition mode
±3% for Sample or Averaged acquisition mode +0.1 divisions.
Volts between any two points, ±3% for Sample or Averaged
acquisition mode +0.02 divisions.

16.1.4 Horizontal
Sample Rate Range
Waveform interpolation
Record Length
Sec/Div Range
Sample Rate and Delay time Accuracy
Sample Clock jitter, typical
Delta Time Measurement Accuracy
Position Range
Captured Sample window duration
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100 MSa/s to 1500 samples/s
Sin(x)/x
1300 – 4,000,000 samples for each channel
10 ns/div to 5 s/div in 1,2,5 sequence
+/50 ppm over any >1 ms interval
1 ps rms
(±1 sample interval + 50 ppm +0.4 ns).
+/- 21.47 secs of the trigger point, with 10 ns resolution.
1 µs – 40 ms with 10ns resolution
40 ms – 42.9 secs with 10 ns - 10 µs resolution.
(Lower sample rates are available for smaller capture buffer sizes)
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16.1.5 Trigger
Trigger Sensitivity, Edge Triggered

Trigger Modes
Trigger Filtering
Trigger Level Range

Trigger Level Accuracy

Trigger Delay Range

Analog Channels – 0.02 Div from DC to 50 MHz
Analog Hardware Trigger – 0.5 div from DC to 100 MHz
External Trigger – 50 mV from DC to 100 MHz
Digital Inputs – 100 mV from DC to 100 MHz
Rear Input – 2.5V fixed
Edge, Window, Pattern, Pulse Duration
Noise reject, HF reject, LF reject
Internal: ±10 divisions from centre of screen
External: ±12.5V in 12 mV increments
Digital: 0 – 10V in 10 mV steps
Internal: ±3%
External: ±3% + 50 mV
Digital: ±3% + 100 mV
0 – 21.47 secs with 10ns resolution.

16.1.6 Digital Inputs
Number
Input impedance
Input voltage range
Threshold range
Threshold sensitivity
Sample Rate

8
100k ±2% in parallel with 10 pF ±2 pF
-16 to + 20V
0 – 10V in 10 mV steps
100 mV
100 MSa/s

16.1.7 Calibration
Calibration method
Calibration Voltage Source

Calibrated Temperature Range
Temperature Compensation

Automatic self calibration
Range
+/-2.5V
Resolution 1 mV
Drift
11 ppm/°C
Accuracy ±1%
0-40 °C in 1 °C steps
Via Internal temperature sensor, ±1.5°C accuracy

16.1.8 Measurements
Cursors

Automated measurements

Custom units
Custom signal names
Custom scaling
User definable colours
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Voltage Difference between cursors
Time difference between cursors
Reciprocal of T in Hertz (1/ T).
DC component
RMS value
Maximum voltage
Minimum Voltage
Peak-Peak
Period
Frequency
Pulse width
Duty Cycle
6 characters
20 characters
Scale + offset by defining two (Vin, Vout) points
Signals, Background, Major Grid, Minor Grid
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16.1.9 Displays
Windows
Capture window functions

Tracking window functions

Spectrum window functions

Information window functions
Control window functions

16.1.10

Simultaneous Capture, Tracking, Spectrum, Information, Maths and Control windows
Defines capture specification for signal acquisition unit, defining amount of time before
trigger, amount of time after the trigger, lower amplitude limit, upper amplitude limit.
Defines Tracking graph time position, when tracking graph is linked.
Defines trigger level and direction
Full zoom and Pan in both axis.
Annotations.
Custom colours
Displays zoomed section of captured signal. Resolution from 10ns to 5s/div.
Full zoom and Pan in both axis.
Annotations.
Custom colours
Display spectrum of signal captured in capture window.
User definable bandwidth
User definable resolution
Full zoom and Pan in both axis.
Annotations.
Custom colours
Displays automated measurements (see below)
User chooses which measurements to show.
Provides graphical control horizontal and vertical settings.
Provides Sample control – single, triggered or automatic.
Provides access to tools – Pan, Zoom, Annotate, and Trigger setting.
Provides Autoscale control.

Mathematical Functions

Operators
Functions on one signal
Processes on one or two signals
Maximum number of mathematical equations

16.1.11

+-*/^():
See the list in 11.2.1 Maths Equations Operators and Functions
See the list in 11.2.2 Maths Equations Processes
8

Spectrum Analysis

Frequency Range
Analysis Output
Output type
Window types
Averaging
Averaging method
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User definable, Range = 0- Fsample/2
RMS Amplitude, Power, Power Density, Gain/Phase
Volts, Power, Gain/Phase in linear, dB, degree or radian values.
Custom units can be applied.
None, Hanning, Hamming, Blackman-Harris, Flat top, Low Sidelobe
Moving average, block average, peak hold.
Vector averaging in time domain if triggered.
RMS averaging in frequency domain if not triggered.
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16.1.12

Windows facilities

Standard Functions

Windows

User settable units
User settable signal names
User settable scaling
User definable colours

16.1.13

Probe Compensator Output

Output Voltage, typical
Output Frequency

16.1.14

Cooling Method
Humidity
Altitude

Weight (approx)

Operating: 0°C to +50°C
Storage:
-20°C to +60°C
Convection
0°C to +40°C
<90% relative humidity
>40°C
<60% relative humidity
Operating
3,000 m
Non-operating 15,000m

Height
35 mm
Width
153 mm
Depth
195 mm (including BNC)
Standard packaging: 2 kg

Expansion Capability

Increase in sampling channels

More Digital Channels
Analog Output
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6-14V DC
5W
100 – 240VAC 50-60 Hz

Mechanical

Size

16.1.17

load

Environmental

Temperature

16.1.16

3V into >100k
1 kHz

Power Source

Source voltage into unit
Power Consumption
Standard power adaptor voltage range

16.1.15

Copy and Paste
Save and Open native format (saves full setup)
Save and Open (*.csv) text file
Print with Date/Time, File Name and Description.
Print Setup
Dynamically resized
Can be placed anywhere on desktop
Can be made to stay in front
6 characters
20 characters
Scale + offset by defining two (Vin, Vout) points
Signals, Background, Major Grid, Minor Grid

Stack two units on top of each other.
100 Mbit/s link provides comms.
Delivers 4 analog, and 16 digital channels.
Plug in digital channel daughter board – 16 inputs
Plug in arbitrary waveform daughter board – 40 MHz bandwidth, up
to 4 MSa sequence.
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